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Important Regulatory and Safety Notices to Service Personnel
Before using this product and any associated equipment, read all the Important Safety Instructions listed below so 
as to avoid personal injury and to prevent product damage.

The BlackStorm system makes use of a number of individual component products to make up a complete turnkey 
system. The Important Safety Instructions section of this manual is intended to compliment individual OEM 
product manuals and the User must refer to, and heed, any safety instruction outline in these supplementary product 
manuals. 

This system may also require specific equipment, and /or installation procedures be carried out to satisfy certain 
other regulatory compliance requirements. Notices have been included in this publication to call attention to these 
specific requirements.



Symbol Meanings

Important Safety Instructions

• Read these instructions. 
• Keep these instructions.
• Heed all warnings.
• Follow all instructions.

Protective Earth — This symbol identifies a Protective Earth (PE) terminal, which is provided for 
connection of the supply system’s protective earth (green or green/yellow) conductor.

This symbol on the equipment refers you to important operating and maintenance (servicing) instructions 
within the Product Manual Documentation. Failure to heed this information may present a major risk of 
damage or injury to persons or equipment.

Warning — The symbol with the word “Warning” within the equipment manual indicates a potentially 
hazardous situation which, if not avoided, could result in death or serious injury.

Caution — The symbol with the word “Caution” within the equipment manual indicates a potentially 
hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to 
alert against unsafe practices.

Warning Hazardous Voltages — This symbol is intended to alert the user to the presence of 
uninsulated “dangerous voltage” within the product enclosure that may be of sufficient magnitude to 
constitute a risk of shock to persons.

ESD Susceptibility — This symbol is used to alert the user that an electrical or electronic device or 
assembly is susceptible to damage from an ESD event.

Warning 1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this apparatus near water.
6) Clean only with a dry cloth.
7) Do not block any ventilation openings. Install in accordance with                                                                                      
manufacturer's instructions. 
8) Do not install near heat sources such as radiators, heat registers, stoves, or other 
apparatus (including amplifiers) that produce heat.
9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized 
plug has two blades with one wider than the other. A grounding type plug has two blades 
and a third grounding prong. The third prong is provided for your safety. If the provided 
plug does not fit in to your outlet, consult an electrician for replacement of the obsolete 
outlet.
10) Protect the power cord from being walked on or pinched particularly at plugs, 
convenience receptacles, and the point where they exit from the apparatus.
11) Only use attachments/accessories specified by the manufacturer.
12) Unplug this apparatus during lightning storms or when unused for long periods of 
time.



13) Refer all servicing to qualified service personnel. Servicing is required when the 
apparatus has been damaged in any way, such as power-supply cord or plug damage, 
liquid has been spilled or objects have fallen into the apparatus, the apparatus has been 
exposed to rain or moisture, does not operate normally, or has been dropped.
14) Do not expose this apparatus to dripping or splashing and ensure that no objects filled 
with liquids, such as vases, are placed on the apparatus. 
15) To completely disconnect this apparatus from the AC Mains, disconnect all power 
supply cord plugs from the AC receptacles. 
16) The mains plug of the power supply cords shall remain readily operable. 
17) The BlackStorm Server chassis is to be rack mounted only. To ensure safe operation 
and maintain long-term system reliability, proper installation requires that the front and 
back area of the chassis are clear from obstructions so as not to restrict airflow.
18) Indoor Use: WARNING: To reduce the risk of fire or electric shock, do not expose this 
apparatus to rain or moisture.
19) The safe operation of this product requires that a protective earth connection be 
provided. A grounding conductor in the equipment's supply cord provides this protective 
earth. To reduce the risk of electrical shock to the operator and service personnel, this 
ground conductor must be connected to an earthed ground.
20) WARNING: This apparatus when equipped with multiple power supplies can generate 
high leakage currents. To reduce the risk of electric shock ensure that each individual 
supply cord is connected to it own separate branch circuit with an earth connection.   
21) Service barriers within this product are intended to protect the operator and service 
personnel from hazardous voltages. For continued safety, replace all barriers after 
servicing.
22) CAUTION: This apparatus contains a Lithium battery, which if replaced incorrectly, 
or with an incorrect type, may cause an explosion. Replace only with the same type 
recommended by the manufacturer. Dispose of used batteries according to the 
manufacturer's instruction by qualified service personnel.
23) Certain parts of this equipment still present a safety hazard, with the power switch in 
the OFF position. To avoid electrical shock, disconnect all A/C power cords from the 
chassis' rear appliance connectors before servicing.
24) This product contains safety critical parts, which if incorrectly replaced may present a 
risk of fire or electrical shock. Components contained within the product's power supplies 
and power supply area, are not intended to be customer serviced and should be returned to 
the factory for repair.
25) To reduce the risk of fire, replacement fuses must be the same type and rating. 
26) Use only power cords specified for this product and certified for the country of use. 
Refer to the Product Power Cord Requirement Section that follows. 
27) The Safe operation of this equipment requires that the User heed and adhere to all 
installation and servicing instruction contained within the equipment's Engineering 
Manuals.



EMC Notices
US FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense.

CANADA

This Class “A” digital apparatus complies with Canadian ICES-003. 

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

EUROPE

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 
93/68/EEC.

INTERNATIONAL

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002 and found to 
comply with the limits for a Class A Digital device.

Warranty and Repair Policy
Ross Video Limited (Ross) warrants its BlackStorm Server systems to be free from defects under normal use and 
service for the following time periods from the date of shipment:

• BlackStorm Server — 12 months
• BlackStorm Server Software Upgrades — 12 months free of charge
• System and Media hard drives — 36 months

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as 
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo 
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, 
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your BlackStorm 
Server system, contact your regional sales manager.

Notice Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could 
void the user’s authority to operate this equipment.

Notice This is a Class A product. In domestic environments, this product may cause radio interference, 
in which case the user may have to take adequate measures.



Environmental Information
The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.

Company Address
Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886 
Fax: (+1) 613 • 652 • 4425 

Technical Support: (+1) 613 • 652 • 4886 
After Hours Emergency: (+1) 613 • 349 • 0006 

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
Thank you for choosing a Ross Video BlackStorm Server.

Ross Video designed the BlackStorm product line with the needs of live production in mind. BlackStorm is an easy 
to use, yet powerful, production server. File-based work flows are supported, which enable easy, networked 
integration of media items that will feed BlackStorm from non-linear editing systems and graphics packages. There 
are a range of available control features, including networked Configuration, Media Manager, Play, and Playlist 
clients. VDCP protocol control is also supported and provides an interface to a wide variety of production 
switchers, controllers and automation systems.

The Unicode character set is supported by the BlackStorm Server user interface to enable the entry, processing, and 
display of international characters for channel, media item, playlist, and bucket names.

We appreciate your business and sincerely hope that you have a great experience with your new BlackStorm Server. 
As always, if there is anything that we at Ross Video can do to assist you, please do not hesitate to contact us.

About This Guide
This guide covers the use of the BlackStorm Video Server. The following chapters are included:

• Chapter 1, “Introduction” summarizes the guide and provides important terms, conventions and feature 
descriptions.

• Chapter 2, “Software Installation” provides instructions for installing BlackStorm Server Client software on a 
separate computer to remotely access the BlackStorm Server.

• Chapter 3, “Server Configuration” provides instructions for using the Configuration Client to configure 
BlackStorm Server communication, inputs, and outputs.

• Chapter 4, “BlackStorm Server Client Layout” provides instructions for creating and saving custom 
BlackStorm Client application layouts to match your work flow.

• Chapter 5, “Adding Media Items to a BlackStorm Server” provides instructions for using the watch folders to 
add media items to a BlackStorm Server.

• Chapter 6, “Playing Media Items from a BlackStorm Server” provides instructions for using the Play Client to 
play media items from a BlackStorm Server.

• Chapter 7, “Working with Playlists” provides instructions for creating and playing out selections of 
custom-ordered media items.

• Chapter 8, “Coloring BlackStorm Clients” provides instructions for changing the background and text color for 
Media Manager, Play, and Playlist Clients.

• Appendix A, “Appendix A. Specifications” describes the basic properties of your BlackStorm Server, including 
specifications and capabilities.

• An Index is also provided for reference.

If you have questions pertaining to the operation of the BlackStorm Video Server, please contact us at the numbers 
listed in the section “Contacting Technical Support” on page 1–3. Our technical staff is always available for 
consultation, training, or service.
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Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and submenus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Media Manager Client, click Channel 1 the Channels section.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the File Name box, enter Channel01.property.

Referenced Guides

Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “GenLock Configuration” on page 3–7 in the BlackStorm User Guide.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “Server > Save As,” you would click the Server menu and then click Save As.

Important Instructions

Star icons are used to identify important instructions or features. For example:

When the Media Manager Client cannot connect to the BlackStorm Server, a Message dialog box opens to report 
the connection problem.

Getting Help
The BlackStorm Server Online Help system is accessed by selecting Help Topics from the Help menu in a 
BlackStorm Server client. Alternatively, press the F1 key while working in a client or dialog box.

The Online Help system contains the following navigation tabs to locate information contained in the Online Help 
topics and User Guide:

• Contents — table of contents
• Index — keyword reference
• Search — full text search
• Favorites — preferred information storage and access

BlackStorm Server guides are also supplied as print-ready PDF files BlackStorm Server Software Installation DVD.
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Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest 
telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service 
and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), 
technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical 
support phone line is available. If the technical support person who is on call does not answer this line immediately, 
a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to 
react to any problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886
• After Hours Emergency: (+1) 613-349-0006
• E-mail: techsupport@rossvideo.com
• Website: http://www.rossvideo.com
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Software Installation
This chapter includes procedures for installing and uninstalling BlackStorm Server Client software on computers 
used to remotely access a BlackStorm Server; as well as, installing and uninstalling BlackStorm Server software on 
a BlackStorm Server computer.

 The following topics are discussed in this chapter:

• BlackStorm Client Usage
• System Requirements
• Client Software Installation and Update
• BlackStorm Server Software Update
• BlackStorm Server Software Uninstall
• BlackStorm Server Services

BlackStorm Client Usage
The BlackStorm Server can be controlled by BlackStorm Clients installed in the following locations:

• On remote computers connected to the BlackStorm Server by a Local Area network.
• Directly on the BlackStorm Server

Working from a Remote Computer

The BlackStorm Server can be accessed by installing Ross Video DashBoard and BlackStorm Client software on a 
remote computer that is connected to the same Local Area network as the BlackStorm Server. BlackStorm Client 
software includes the following applications:

• Configuration Client
• Media Manager
• Play Client
• Playlist Client

Before installing BlackStorm Client software on a computer, verify that the computer meets the following 
requirements:

• The remote computer must meet the system requirements recommended by Ross Video to run BlackStorm Client 
software. For more information, refer to the section “System Requirements” on page 2–2.

• Folders must be able to be shared over the network with the BlackStorm Server. Refer to the section “Firewall 
Configuration” on page 3–3 for further information on sharing folders over the network.

For More Information on...
• BlackStorm Server clients, refer to the following sections:

› “Server Configuration” on page 3–1
› “Adding Media Items to a BlackStorm Server” on page 5–1
› “Playing Media Items from a BlackStorm Server” on page 6–1
› “Working with Playlists” on page 7–1

Working Directly from the BlackStorm Server

A monitor, keyboard, and mouse can be connected to the peripheral ports on the back or front of the BlackStorm 
Server to use the installed BlackStorm Client software on the BlackStorm Server. Refer to the Cabling Your 
BlackStorm Server Quick Start Guide for further information on the rear peripheral connections of the BlackStorm 
Server.
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System Requirements
To ensure that BlackStorm Client software will function correctly, verify that the selected computer to install 
BlackStorm Client software meets the requirements described in the following sections.

Hardware

Ross Video recommends the following minimum computer hardware configuration to run BlackStorm Client 
software:

• Intel® Pentium 4, 1.6 GHz (Intel® Core™ 2 Duo recommended)
• 1 GB or more of RAM (2GB is recommended)
• 450 MB free disk space

Software

Ross Video recommends the following minimum computer software configuration to run BlackStorm Client 
software:

• Ross Video DashBoard 5.0.0 or higher
• Microsoft® Windows® XP Professional or Microsoft® Windows® 7
• Microsoft® Internet Explorer® version 5 (minimum)

Ensure that the operating system is updated with all necessary security patches and service packs before 
installing BlackStorm Client software on a computer.

Client Software Installation and Update
Before a remote computer can be used to access a BlackStorm Server, the computer must be able to access a 
running BlackStorm Server and the following software must be installed on the computer:

• DashBoard™ Control System — The DashBoard application installer is contained on the BlackStorm Server 
Software DVD shipped with the BlackStorm Server, or is downloadable from the Ross website.
When installing DashBoard, it is recommended to clear the openGear Control box on the Choose Components 
screen.

• BlackStorm Server Clients — Client software is installed in DashBoard from a BlackStorm Server.
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For More Information on...
• installing or un-installing the DashBoard application, refer to the DashBoard Control System User Manual and 

the DashBoard Online Help system.
• updating DashBoard plug-ins, refer to the DashBoard Control System User Manual and the DashBoard Online 

Help system.
• downloading the Dashboard application installer, refer to the Terminal Equipment | openGear | Control & 

Monitoring | DashBoard section of the Ross Video website.

DashBoard Configuration for BlackStorm Server Clients

The DashBoard application on a Client computer must be configured to work with the BlackStorm Server before 
the BlackStorm Server Clients can be installed in DashBoard.

To configure DashBoard for BlackStorm Server Clients:

1. On the Client computer, verify that the following conditions are true:

• The current version of DashBoard software is installed on the Client computer.
When installing DashBoard, it is recommended to clear the openGear Control box on the Choose 
Components screen.

• The Client computer can access a running BlackStorm Server on the network.

2. Use one of the following methods to launch DashBoard:

• Double-click the DashBoard icon on the desktop.
• Use the Start menu to select All Programs > DashBoard > DashBoard.

DashBoard opens.

3. Use the Window menu to select Preferences.

The Preferences dialog box opens.
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4. In the tree view, select Automatic Discovery.

The Automatic Discovery panel opens.

5. In the Automatic Discovery of Devices section, select the Disable option.

6. In the tree view, expand the Install/Update node and select Available Software Sites.

The Available Software Sites panel opens.

7. Clear all of the check boxes in the Name column.
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8. Click Add.

The Add Site dialog box opens

9. In the Name box enter a name to describe the software site.

10. In the Location box, enter the hostname or IP address of the BlackStorm Server with the following suffix:

:8080/Plugin/BlackStorm 

Your Network Administrator can provide you with the IP address or hostname of your BlackStorm Server.

To use a BlackStorm Server with the hostname of Media-One and an IP address of 192.168.1.1 as a 
software download site for BlackStorm Server Client software, enter one of the following URLs in the 
Location box:

• http://Media-One:8080/Plugin/BlackStorm 
• http://192.168.1.1:8080/Plugin/BlackStorm 

11. Click OK.

The Add Site dialog box closes and the new software site is added the list of available software sites.

12. Select the check box to the left of the new software site if it is not already selected.

13. Click OK.

The set preferences are saved and the Preferences dialog box closes.

14. In DashBoard, remove all of the nodes from the Tree View.
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15. Use the File menu to select New > Manual Connection.

The Manually Detect Device dialog box opens.

16. In the IP Address box, enter the hostname or IP address of the BlackStorm Server. This hostname or IP address 
is the same as the hostname or IP address entered in the Add Site dialog box (step 10 on page 2-5).

17. Click Detect Settings.

The Attribute and Value columns display information about the selected BlackStorm Server.

When settings cannot be detected for the selected BlackStorm Server, use one of the following methods to 
restart the BlackStormHttpService:

• On the BlackStorm Server, use the Services tab in the Windows Task Manager to restart the 
BlackStormHttpService.

• Restart the BlackStorm Server.

18. Click Finish.

A node for the BlackStorm Server is added to the DashBoard Tree View.

DashBoard is configured and ready for the installation of BlackStorm Server Client software from the BlackStorm 
Server displayed in the DashBoard Tree View.

BlackStorm Server Node
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Installing BlackStorm Server Clients

After configuring DashBoard on a Client computer, BlackStorm Server Clients can be installed in DashBoard.

To install BlackStorm Client software in DashBoard on a Client computer:

1. On the Client computer, verify that the following conditions are true:

• The current version of DashBoard software is installed on the Client computer.
When installing DashBoard, it is recommended to clear the openGear Control box on the Choose 
Components screen.

• The DashBoard software is configured to access a BlackStorm Server.
• The Client computer can access a running BlackStorm Server on the network.

2. In the DashBoard Tree View, double-click the BlackStorm Server node (  ) from which to install 
BlackStorm Client software.

The Install wizard opens.

3. In the Name column of the Available Software screen, select the BlackStorm Video Server check box if it is 
not already selected.

4. Clear the Group items by category check box.

BlackStorm Server Node
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5. Click Next.

The Install Details screen opens.

6. Click Next.

The Review Licenses screen opens.

7. Select the I accept the terms of the license agreement option.

8. Click Finish to begin updating BlackStorm Client software.

A progress bar displays the installation status.

After the installer finishes installing the required files, the Software Updates dialog box opens.
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9. Click Yes.

The computer restarts to complete the installation of BlackStorm Client software.

10. Manually add the BlackStorm Server to Dashboard by following step 15 on page 2-6 to step 18 on page 2-6 in 
the To configure DashBoard for BlackStorm Server Clients: procedure.

A node for the BlackStorm Server is added to the DashBoard Tree View.

11. Hover the mouse over the BlackStorm Server node to view the following information about the BlackStorm 
Server:

• IP address
• Installed software version
• Client to Server connection status

12. Expand the BlackStorm Server node to access the BlackStorm Server Clients.

Updating BlackStorm Server Clients

After the software on a BlackStorm Server is updated, the BlackStorm Server Client software on Client computers 
should be updated to make use of the new features of the updated BlackStorm Server.

To update BlackStorm Client software on a computer:

1. On the Client computer, use one of the following methods to launch DashBoard:

• Double-click the DashBoard icon on the desktop.
• Use the Start menu to select All Programs > DashBoard > DashBoard.

DashBoard opens.

2. From the Help menu, select Check for Updates.

The Available Updates wizard opens.

3. In the Name column of the Available Updates screen, select the BlackStorm Video Server check box if it is 
not already selected.

It is optional to select any additional updates listed with the BlackStorm Video Server update. To skip over 
the installation of an update, clear the associated check box in the Name column.

BlackStorm Server Node
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4. Click Next.

The Update Details screen opens.

5. Click Next.

The Review Licenses screen opens.

6. Select the I accept the terms of the license agreement option.

7. Click Finish.

A progress bar displays the installation status BlackStorm Client software update.

After the installer finishes installing the required files, the Software Updates dialog box opens.

8. Click Yes.

DashBoard restarts to complete the update of BlackStorm Client software.
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BlackStorm Server Software Update
After each new release of BlackStorm Server software, the software on existing BlackStorm Servers should be 
updated with the newly released BlackStorm Server software. BlackStorm Server software updates can be 
downloaded from Ross Video.

The overall SoftMetal Server software update process from BlackStorm version 1.0 to 1.1 includes the following 
procedures:

• “To update BlackStorm Server software from version 1.0 to 1.x:” on page 2–11
• “To check the version of the BlackStorm Server AJA Corvid 22 card firmware:” on page 2–13
• “To update AJA Corvid 22 card firmware to version 13:” on page 2–13

To update BlackStorm Server software from version 1.0 to 1.x:

1. Log on to the BlackStorm Server computer using the following user name and password:

• User name — blackstorm
• Password — blackstorm

2. Shut down all Windows applications.

3. Right-click the BlackStorm Service Manager icon in the System Tray and select Exit to exit the BlackStorm 
Service Manager.

The BlackStorm Service Manager closes and the icon is removed from the System Tray.

4. Download the BlackStorm Version 1.1.zip file from Ross Video.

5. Unzip the BlackStorm Version 1.1.zip file to the desktop.

6. On the desktop, open the BlackStorm Version 1.X folder.

7. Double-click BlackStorm-Installer-1.1.0.####.exe.

The BlackStorm-1.1.0.#### Setup wizard opens.

BlackStorm Service Running BlackStorm Service Stopped

BlackStorm Service Icon
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8. Click Install to begin updating BlackStorm Server software.

The Installing screen opens to display the progress of the software installation.

During the installation, various other installers are also run to install components of the BlackStorm Server. 
After the installer finishes installing the required files, the Completing the BlackStorm-1.1.0.#### Setup 
Wizard screen opens.

9. Select the Reboot now option

10. Click Finish.

The BlackStorm Server computer restarts to complete the installation of the BlackStorm Server software.
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To check the version of the BlackStorm Server AJA Corvid 22 card firmware:

1. On the BlackStorm Server computer, use the Start menu to select All Programs > AJA > XenaControlPanel.

The XenaControlPanel icon is added to the System Tray.

2. In the System Tray, click the XenaControlPanel icon and select About from the menu.

The About tab opens in the Control Panel for Corvid22 dialog box.

3. Check the firmware version displayed in the PCI FPGA Version field.

4. Depending on the version of the installed firmware, continue the BlackStorm Server software upgrade with one 
of the following procedures:

• If the firmware version is NOT d, continue with the procedure “To update AJA Corvid 22 card firmware 
to version 13:” on page 2–13.

• If the firmware version is d, the AJA Corvid 22 card does not require a firmware update.

5. Close the Control Panel for Corvid22 dialog box.

To update AJA Corvid 22 card firmware to version 13:

1. On the BlackStorm Server computer, locate the corvid22firmware_13.zip file in the 
C:\ross\BlackStorm\AJADrivers folder.

2. Unzip the corvid22firmware_13.zip file to the desktop.

3. On the desktop, open the corvid22firmware_13 folder.

Xena Control Panel
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4. Double-click pciburner.exe.

The PCI Bitfile Burner dialog box opens.

5. Double-click in the Update To PCI Bitfile box.

The Open Video File dialog box opens.

6. Select the Corvid22_13.bit file from the corvid22firmware_13 folder.

7. Click OK.

The Open Video File dialog box closes and the Corvid22_13.bit file is added to the Update To PCI Bitfile 
box.

8. Click Start.

After the installer finishes installing the firmware, the Reboot dialog box opens.

9. Click OK.

The BlackStorm computer reboots to complete the installation of the AJA Corvid 22 card firmware.
2–14 • Software Installation BlackStorm Video Server User Guide (v1.1)



BlackStorm Server Software Uninstall
The BlackStorm Uninstall Wizard can be used the uninstall BlackStorm Server software from a server computer.

To uninstall BlackStorm software from the server:

1. Log on to the BlackStorm Server computer using the following user name and password:

• User name — blackstorm
• Password — blackstorm

2. From the Start Menu, select All Programs > BlackStorm > Uninstall.

The BlackStorm-1.1.0.#### Uninstall wizard opens.

3. Click Next.

The Uninstall BlackStorm-1.1.0.#### screen opens.
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4. Click Uninstall to begin uninstalling BlackStorm Server software.

The Uninstalling screen opens to display the progress of the software removal.

After the BlackStorm-1.1.0.#### Uninstall wizard has removed the required files, the Completing the 
BlackStorm-1.1.0.#### Uninstall screens opens.

5. Select the Reboot now option

6. Click Finish.

The BlackStorm Server computer restarts to complete the removal of BlackStorm software from the server 
computer.

BlackStorm Server Services
The following services run on the BlackStorm Server computer to enable the BlackStorm Server playout media 
items, catalog media items, and work with DashBoard:

• BlackStorm Server — plays out media items from the BlackStorm Server.
• Database — catalogs media items in the BlackStorm Server Media database.
• Service Location Protocol (SLP) — locates BlackStorm Servers on the local network.
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The BlackStorm Server icon in the System Tray reports the status of BlackStorm Server services, and it is also used 
to control BlackStorm Server services.

When the BlackStorm Server or Database Status LED in a BlackStorm Server Client turns red, the associated 
service may have stopped. A stopped service can be started using the BlackStorm Server icon in the System tray of 
the BlackStorm Server computer.

To control BlackStorm Server services:

1. To stop a service, right-click the BlackStorm Service Manager icon in the System Tray and select one of the 
following commands:

Stopping the SLP service also stops the BlackStorm Server service.

The BlackStorm Service Manager icon turns red when the BlackStorm Service is stopped.

2. To start a service, right-click the BlackStorm Service Manager icon in the System Tray and select one of the 
following commands:

The BlackStorm Service Manager icon turns green when the BlackStorm Service is running. Starting the 
BlackStorm Server service also starts the SLP service.

Service Command
BlackStorm Server BlackStorm Server > Stop 

Database Database > Stop 

Service Location Protocol SLP > Stop 

All Stop All 

Service Command
BlackStorm Server BlackStorm Server > Start 

Database Database > Start 

Service Location Protocol SLP > Start 

All Start All 

BlackStorm Service Running BlackStorm Service Stopped

BlackStorm Service Icon
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Server Configuration
The Configuration Client provides all of the properties to set up the BlackStorm Server inputs and outputs. 
Properties must be set using the Config Client before the BlackStorm Server can be used for video playout.

This chapter describes how to use the Config Client to configure the BlackStorm Server communication, inputs, 
and outputs.

 The following topics are discussed in this chapter:

• Logging on to the Server
• Network Connections
• Server Performance
• Firewall Configuration
• Client Configuration
• Channel Name Configuration
• GenLock Configuration
• Remote Control Configuration
• House Time Configuration
• Channel Time Configuration

Logging on to the Server
When working directly from the BlackStorm Server, a user must log on to Windows using a user name and 
password.

Ross Video recommends that the BlackStorm Server passwords be maintained as per company Network 
Administrator policy.

The following user names and passwords are configured for use on the BlackStorm Server:

Default User

BlackStorm is the default user that is typically used for routine operation of the BlackStorm Server and to configure 
the Server. Use the following user name and password to log on to the BlackStorm Server as the default user:

• User name — blackstorm
• Password — blackstorm

Administrator

When managing the operating system of a BlackStorm Server or running consistency checks on the system and 
media drives, log on to the BlackStorm Server with the following user name and password:

• User name — administrator
• Password — pr0gram

When entering the password, use the number zero (0) to replace the letter “o”.
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Network Connections
In order for the BlackStorm Server to function, it must be attached to a network. A network connection enables 
remote access to the BlackStorm Server, and remote BlackStorm Clients to access media stored on the BlackStorm 
Server.

Ross Video recommends that any required network configurations be performed by a qualified Network 
Administrator. Some network settings, if configured incorrectly, could prevent the BlackStorm Server from 
communicating on the network.

Keep the following in mind when configuring the BlackStorm Server network connections:

• If the network within the production environment does not use bridges to connect subnets, the BlackStorm 
Server must be located on the same subnet as the remote client machines.

• When assigning an IP address to the BlackStorm Server, Ross Video recommends assigning a static IP address, 
rather than using DHCP to dynamically assign an IP address. Since a static IP address does not change when the 
BlackStorm Server is restarted, BlackStorm Clients can always connect the BlackStorm Server without having to 
reconfigure the BlackStorm Server IP address.

Multiple Network Interface Cards

When a BlackStorm Server is configured with multiple network interface cards, the static IP address of the 
BlackStorm Server must be bound to one network interface card. 

Complete the following procedures to set the BlackStorm Server IP address for FTP, BlackStorm client user 
interface, and external controllers (VDCP and AMP):

To set the BlackStorm Server IP address for FTP:

1. Check with your IT Department for the IP address or hostname of your BlackStorm Server.

2. Navigate to the C:\Ross\BlackStorm folder.

3. Use a text editor to open and edit the FTPConfig.xml file.

4. In the FTPConfig.xml file, locate the following line of text:

<m_strBoundIp type="string"/> 

5. Replace the found line of text with the following line of text, where 192.168.1.1 is the IP address or 
hostname of your BlackStorm Server:

<m_strBoundIp type="string">192.168.1.1</m_strBoundIp> 

6. Save the updated FTPConfig.xml file.

7. Stop and start BlackStorm Server service.

To set the BlackStorm Server IP address for the user interface of BlackStorm clients:

1. Check with your IT Department for the IP address or hostname of your BlackStorm Server.

2. Navigate to the C:\Ross\BlackStorm folder.

3. Use a text editor to open and edit the HttpConnectionServiceConfig.xml file.

1. In the HttpConnectionServiceConfig.xml file, locate the following line of text:

<m_boundAddress type="string"/> 

2. Replace the found line of text with the following line of text, where “192.168.1.1” is the IP address or 
hostname of your BlackStorm Server:

<m_boundAddress type="string">192.168.1.1</m_boundAddress> 

3. Save the updated HttpConnectionServiceConfig.xml file.

4. In the SOAPConfig.xml file, locate the following line of text:

<m_boundAddress type="string"/> 
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5. Replace the found line of text with the following line of text, where “192.168.1.1” is the IP address or 
hostname of your BlackStorm Server:

<m_boundAddress type="string">192.168.1.1</m_boundAddress > 

6. Save the updated SOAPConfig.xml file.

7. Stop and start BlackStorm Server service.

To set the BlackStorm Server IP address for external controllers:

1. Check with your IT Department for the IP address or hostname of your BlackStorm Server.

2. Navigate to the C:\Ross\BlackStorm folder.

3. Use a text editor to open and edit the ControllerPortsConfig.xml file.

4. In the ControllerPortsConfig.xml file, locate the following line of text:

<m_boundIpAddress type="string"/> 

5. Replace the found line of text with the following line of text, where 192.168.1.1 is the IP address or 
hostname of your BlackStorm Server:

<m_boundIpAddress type="string">192.168.1.1</m_boundIpAddress> 

6. Save the updated ControllerPortsConfig.xml file.

7. Stop and start BlackStorm Server service.

Server Performance
Virus scanning software and Automatic Updates can impact the performance a BlackStorm Server. To ensure peak 
performance, BlackStorm Servers are shipped from the factory as follows:

• Virus scanning software not installed
• Automatic Updates turned off

Contact Ross Technical Support for information about running virus scanning software and/or Automatic Updates 
on a BlackStorm Server.

Firewall Configuration
In order to use BlackStorm Server software directly from the BlackStorm Server, the Windows Firewall must be 
disabled. If the Firewall is left enabled, BlackStorm Clients cannot launch or function properly.

The BlackStorm Server ships from the factory with the Firewall disabled.

To disable the Windows Firewall on the BlackStorm Server:

1. From the Start Menu, select Control Panel.

The Control Panel window opens.

2. Use the View by list to select Large icons.

3. Click the Windows Firewall control panel.

The Windows Firewall window opens.

4. In the panel to the left, select Turn Windows Firewall on or off.

The Customize Settings window opens.

5. For each Network Location, select the Turn off Windows Firewall option.

6. Click OK.

The Firewall on the BlackStorm Server is now disabled.

7. Close the Control Panel window.
BlackStorm Video Server User Guide (v1.1) Server Configuration • 3–3



Client Configuration
The address of the FTP server and the ports used to communicate with the FTP server must be set to enable media 
items to be loaded onto and exported from the BlackStorm Server.

To configure FTP server settings and client information logging level:

1. Use one of the following methods to launch the DashBoard software:

• Double-click the DashBoard icon on the desktop.
• Use the Start menu to select All Programs > DashBoard > DashBoard.

DashBoard opens.

2. In the DashBoard Tree View, expand your BlackStorm Server node (  ).

The available channels, applications, and tools are listed below the BlackStorm Server node.

3. Expand the Configuration Tools node (  ).

The available configuration tool is listed below the Configuration Tools node
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4. Double-click the Configure Client node (  ).

The Configuration Client opens in the Device View.

5. Click the Client tab.

The Client tab opens.

6. An FTP Server runs on the BlackStorm Server computer to enable file transfers between the BlackStorm 
Server and the Media Manager Client or FTP clients. When the word default is displayed in the FTP Server 
Address box it indicates that the BlackStorm FTP Server address is set to the hostname and IP address 
displayed in the Server Name field.

When a BlackStorm Server computer contains a two network interface cards, complete the following steps to 
set the IP address of the BlackStorm FTP Server:

a. Enter the IP address of the second network interface card in the FTP Server Address box.

Check with your IT Department if you do not know the IP address or hostname of your BlackStorm or FTP 
Server.

b. In Windows, Navigate to the C:\Ross\BlackStorm folder.

c. Edit the FTPConfig.xml file and locate the following line of text:

<m_strBoundIp type="string"/> 

d. Replace the found line of text with the following line of text, where 192.168.1.1 is the IP address 
entered in the FTP Server Address box:

<m_strBoundIp type="string">192.168.1.1</m_strBoundIp> 

e. Save the updated FTPConfig.xml file.

f. Stop and start BlackStorm Server service.

7. In the FTP Data Port box, enter the port number used by the FTP Server on the BlackStorm Server computer 
to exchange data with BlackStorm Server Clients.

The default FTP Data Port is port 20.

8. In the FTP Control Port box, enter the port number used to control the FTP Server on the BlackStorm Server 
computer.

The default FTP Control Port is port 21.
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9. In the Client Diagnostics section, use the Logging Level list  to select the level of information to log. Logs can 
be used to troubleshoot client connection issues. Messages more severe than the selected level are logged along 
with the selected logging level. Select from the following logging levels:

• SEVERE — log messages indicating a serious failure. This level captures the least information.
• WARNING — log messages indicating a potential problem. Also log SEVERE messages.
• INFO — log informational messages. Also log SEVERE and WARNING messages.
• ALL — log SEVERE, WARNING, and INFO messages. This level captures the most information and may 

impact server performance.

10. Click Apply.

For More Information on...
• stopping and starting the BlackStorm Server service, refer to the section “BlackStorm Server Services” on 

page 2–16.

Channel Name Configuration
Channel names can be added to channel numbers to help clarify selecting an output channel from a BlackStorm 
Client. Names are assigned to BlackStorm Server channels on the Channel Name tab in the Config Client.

Channel names are stored on the Client computer used to run the Config Client. BlackStorm Server Clients run on a 
Client computer use the channel names set on the Client computer. To use channel names on other Client 
computers, channels names must be set on each Client computer used to run BlackStorm Server Clients.

To assign names to the channels of a BlackStorm Server:

1. In the Configuration Client, click the Channel Names tab.

The Channel Names tab opens.

2. For each BlackStorm Server Output Channel, enter a name for the channel in the Name box to the right of the 
channel number. Twenty characters is the maximum length for a channel name.

To clear the current channel name from the Name box associated with a channel, click Clear to the right of the 
Name box. Click Clear All to clear channel names from all of the Name boxes.

When the Name box associated with a channel is left empty, the channel name is automatically generated by 
adding the word “Channel” to the channel number.

3. Click Apply.

BlackStorm Server Clients and nodes in the DashBoard Tree View are updated with the new channel names.
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GenLock Configuration
BlackStorm Server video output GenLock properties are set on the GenLock tab in the Config Client. This tab is 
also used to set the resolution for all BlackStorm Server output channels.

Output channel resolution can only be changed while channels are idle and all media items ejected.

To configure BlackStorm Server GenLock and global output settings:

1. In the Configuration Client, click the GenLock tab.

The GenLock tab opens.

2. In the Resolution section, use the Resolution list to select the proper resolution and field or frame rate for all 
BlackStorm Server output channels. The available resolutions are as follows:

• 1080i 50 — 1920 x 1080 interlaced resolution with a field rate of 50 Hz
• 1080i 59.94 — 1920 x 1080 interlaced resolution with a field rate of 59.94 Hz
• 720p 50 — 1280 x 720 progressive resolution with a frame rate of 50 Hz
• 720p 59.94 — 1280 x 720 progressive resolution with a frame rate of 59.94 Hz
• 480i — 480 interlaced lines (NTSC) with a field rate of 59.94 Hz
• 576i — 576 interlaced lines (PAL) with a field rate of 50 Hz

3. In the Source section, use the Source list to select the source of the genlock signal. This signal is required to 
lock the BlackStorm Server to the video timing of your facility. Ross Video recommends using an external 
reference for the genlock signal source. The available genlock signal sources are as follows:

• Free Run — do not synchronize the BlackStorm Server with a genlock signal from an external source.
• External — synchronize with a genlock signal received from an external application through the REF IN 

BNC connector of the BlackStorm Server computer. The BlackStorm Server accepts Analog Color Black or 
HD Tri-level sync genlock signals. Tri-level sync is recommended for progressive and HD formats.

The Genlock Status LED icon uses the following states to indicate the status of the selected genlock signal 
source for the BlackStorm Server.

•  — locked to the genlock signal source

•  — free running

•  — not locked to the genlock signal source

4. Click Apply to save the GenLock and resolution settings.
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Remote Control Configuration
The control ports and communications protocols used to remotely control the BlackStorm Server must be 
configured before the BlackStorm Server can be controlled from remote devices.

To configure the remote control ports and communication protocols:

1. In the Configuration Client, click the Remote Control tab.

The Remote Control tab opens.

2. To control the BlackStorm Server with a remote device connected to a Serial Control port of the BlackStorm 
Server computer, use the Com3 and Com4 lists to set the communication protocol for the associated RS-422 
Serial Control port of the Breakout cable or panel connected to the BlackStorm Server. The available 
communication protocols are as follows:

• VDCP — receive VDCP commands through the associated Serial Control port. The VDCP protocol uses a 
tightly-coupled master/slave method of communication. The controlling device initiates communication 
between itself and the controlled device.

• None — do not receive remote control commands through the associated Serial Control port.

3. Select the Enable VDCP over Ethernet check box to receive Video Disk Communications Protocol (VDCP) 
commands through the GigE Ethernet port on the back of the BlackStorm Server.

4. Select the Enable AMP over Ethernet check box to receive Advanced Media Protocol (AMP) commands 
through the GigE Ethernet port on the back of the BlackStorm Server.

The BlackStorm Server supports AMP control by the Ross Video Carbonite switcher. AMP control of the 
BlackStorm Server is not certified with other control devices.

5. Select the Use Server-entered Trimpoints check box to use media item trimpoints when the BlackStorm 
Server does not receive trimpoints from an upstream controller as part of a VDCP Cue command.

Regardless of this check box being selected, the BlackStorm Server always uses trimpoints received from an 
upstream controller.

6. Click Apply to save the remote control settings.

An Info dialog box opens.

7. Click OK.
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For More Information on...
• BlackStorm Server supported VDCP commands, refer to the section “VDCP Commands for the BlackStorm 

Server” on page 9–2.
• Serial Control port pinouts, refer to the section “Communication Serial Port” on page 9–3.

Mapping VDCP Ports

The BlackStorm Server uses a one to one mapping to set the association between BlackStorm Server channel to 
control and VDCP port. For example, VDCP port 1 controls Server output channel 1. Custom VDCP port mappings 
are defined using the Port Mapping dialog box.

To set the BlackStorm Server channel controlled by a VDCP port:

1. In the Remote Control tab of the Configuration Client, click VDCP Port Mapping.

The Port Mapping dialog box opens.

2. Use the Port box to enter or select the VDCP port to control a BlackStorm Server channel. The available 
VDCP ports are 1 to 256.

3.  Use the Channel Type list to select the type of BlackStorm channel controlled by the selected VDCP Port. 
The available channel types are as follows:

• Output — control an output channel, selected from the Channel list.
• None — do not control a channel.

4.  Use the Channel list to select the Output channel on the BlackStorm Server to control. The available channels 
depend on the selected Channel Type and BlackStorm Server configuration.

5. Click OK to save the set VDCP port mappings and close the Port Mapping dialog box.

An Info dialog box opens.

6. Click OK.
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House Time Configuration
The house time signal source for a BlackStorm Server is selected and configured on the House Time tab in the 
Configuration Client. After selecting and configure a house time signal source, the Timecode Client can be used to 
view the current house time.

To configure the house time source for a BlackStorm Server:

1. In the Configuration Client, click the House Time tab.

The House Time tab opens.

2. Select one of the following options to choose the time signal source used to set house time:

• None — do not receive a time signal for house time. When this option is selected, the House Time section 
in the Timecode Client does not display a the current house time ( --:--:--:-- ).

• LTC — set house time using a Linear Timecode (LTC) time signal received from one of the LTC In ports 
on the back of the BlackStorm Server. After selecting this option, continue with 3 step in this procedure.

• NTP Server — set house time using a time signal received from a Network Time Protocol (NTP) server. 
After selecting this option, continue with 4 step in this procedure.
The timecode returned by a NTP server is Coordinated Universal Time (UTC). To display the local time in 
the House Time section of the Timecode Client, the local time zone must be set on the BlackStorm Server 
computer. To set the local time zone on the BlackStorm Server:
› Log on to the BlackStorm Server computer as the blackstorm user.
› From the Start Menu, select Control Panel.
› In the Control Panel window, use the View by list to select Large icons.
› Click the Date and Time control panel.
› In the Time zone section of the Date and Time dialog box, click Change time zone.
› In the Time Zone Settings dialog box, use the Time zone list the select the local time zone.
› Select the Automatically adjust clock for Daylight Saving Time check box.
› Click OK.
› In the Date and Time dialog box, click OK.
› Close the Control Panel window.

3. Use the list to the right of the LTC option to select the LTC In port number on the back of the BlackStorm 
Server from which to receive a time signal for house time.

After selecting this option, continue with 7 step in this procedure

4. In the box to the right of the NTP Server option, enter the IP address or hostname of the NTP Server from 
which to receive a time signal for house time.
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5. Click Test NTP to verify that a time signal can be received from the selected NTP server.

6. In the Polling Interval box, enter the number of seconds to wait between contacting the NTP server for values 
used to update the local house time on the BlackStorm Server.

Shorter polling intervals can be used to correct large errors in local house time, while longer intervals can help 
refine local house time accuracy.

7. Click Apply to save the House Time settings.

Channel Time Configuration
The Channel Time tab in the Configuration Client is used to set where the timecode signal from each BlackStorm 
Server output channel is sent. When the media item loaded on a channel contains a QuickTime Timecode Track, the 
timecode from the QuickTime Timecode Track is sent to the selected output. When a media item does not contain a 
QuickTime Timecode Track, a timecode is generated from the media item frame count.

When a BlackStorm Server sends out a timecode signal as an Ancillary Time Code (ATC) or through a Linear 
Timecode (LTC) port, the Frames field of the timecode is limited to 30 frames per second (FPS) in accordance 
with the SMPTE 12M-1-2008 specification.

To configure the timecode output from a BlackStorm Server channel:

1. In the Configuration Client, click the Channel Time tab.

The Channel Time tab opens.

2. In the Channel 1 section, select the ATC Insertion check box to embed the timecode retrieved from the media 
item playing out on channel 1 of the BlackStorm Server in the channel 1 video signal as an ATC.

3. Select the LTC Out check box to output the timecode retrieved from the media item playing out on channel 1 
of the BlackStorm Server through the LTC Out 1 port on the back of the BlackStorm Server.

4. Use the Duration list to select the duration format for the selected channel 1 timecode outputs. The available 
duration formats are as follows:

• Ascending — the timecode counts up from the start of a media item and reports the length of time that the 
media item has been playing out.

• Descending — the timecode counts down from the end of a media item and reports the remaining time that 
the media item can be played out.

5. In the Channel 2 section, select the ATC Insertion check box to embed the timecode retrieved from the media 
item playing out on channel 2 of the BlackStorm Server in the channel 2 video signal as an ATC.
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6. Select the LTC Out check box to output the timecode retrieved from the media item playing out on channel 2 
of the BlackStorm Server through the LTC Out 2 port on the back of the BlackStorm Server.

7. Use the Duration list to select the duration format for the selected channel 2 timecode outputs. The available 
duration formats are as follows:

• Ascending — the timecode counts up from the start of a media item and reports the length of time that the 
media item has been playing out.

• Descending — the timecode counts down from the end of a media item and reports the remaining time that 
the media item can be played out.

8. Click Apply to save the Channel Time settings.
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BlackStorm Server Client Layout
The BlackStorm Server Client applications used to control and configure a BlackStorm Server are part of the Ross 
Video DashBoard Control System™ application. Dashboard enables monitoring and control one or more 
BlackStorm Servers from a computer. Through DashBoard, you can create and save custom BlackStorm Client 
application layouts that match your work flow.

DashBoard comes pre-installed on your BlackStorm Server. For remote computer connected to the same Local Area 
network as the BlackStorm Server, Dashboard is free application that can be downloaded from the Ross Video 
website.

The following topics are discussed in this chapter:

• Connecting to a BlackStorm Server
• Accessing BlackStorm Server Clients in Dashboard
• Creating a BlackStorm Client Layout
• Saving a BlackStorm Client Layout

The procedures in this chapter build upon each other to create a well-suited layout for playing out media items from 
the BlackStorm Server. The completed layout enables easy access to the Media Manager, Channel, and Playlist 
clients.

Figure 4.1  Completed Layout

For More Information on...
• Dashboard, refer to the DashBoard User Guide.
• downloading the Dashboard application installer, refer to the following section of the Ross Video website:

› Products | Terminal Equipment | openGear | Control & Monitoring | DashBoard 
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Connecting to a BlackStorm Server
The BlackStorm Server or Servers controlled by DashBoard are manually added to the DashBoard Tree View when 
the BlackStorm Client software is installed on a remote computer. Each BlackStorm Server is displayed in the 
DashBoard Tree View as a node (Figure 4.2). Each BlackStorm Server node contains the BlackStorm Server 
Clients used to control the associated BlackStorm Server. BlackStorm Server nodes are named with the BlackStorm 
Server IP address or hostname.

Figure 4.2  BlackStorm Server Node in the DashBoard Tree View

Connection Status

The LED in the lower right corner of a BlackStorm Server node indicates the current connection status between 
DashBoard and the BlackStorm Server. The LED reports the following connection states:

Accessing BlackStorm Server Clients in Dashboard
After adding a BlackStorm Server to DashBoard, BlackStorm Server Clients can be opened to configure and control 
the BlackStorm Server. The BlackStorm Server node contains all of the available BlackStorm Server Clients.

To Open BlackStorm Server Clients:

1. Use one of the following methods to launch the DashBoard software:

• Double-click the DashBoard icon on the desktop.
• Use the Start menu to select All Programs > DashBoard > DashBoard.

DashBoard opens.

2. In the DashBoard Tree View, expand your BlackStorm Server node (  ).

The expanded BlackStorm Server node lists the available channels, applications, and tools.

Table 4.1  BlackStorm Server Connection States

LED State
DashBoard is connected to the BlackStorm Service running on the 
BlackStorm Server computer.

DashBoard is trying to establish a connection with the BlackStorm Server, 
but there may be a connectivity problem. For example, there is no FTP 
connection with the BlackStorm Server.

DashBoard is not connected to the BlackStorm Service running on the 
BlackStorm Server computer. Check with your IT Department to verify 
that the BlackStorm Service and Server are running.

The connect state between DashBoard and the BlackStorm Server is 
unknown.

BlackStorm Server Node
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3. Expand the Channels, Control Applications, and Configuration Tools nodes to access the available 
BlackStorm Clients.

The available BlackStorm Clients are as follows:

Creating a BlackStorm Client Layout
In DashBoard, each BlackStorm Server Client can be opened in the Device View area to the right of the Tree View. 
Newly opened BlackStorm Server Clients occupy the entire Device View. When multiple BlackStorm Server 
Clients are opened in the Device View, the clients can be moved and resized to tailor the Device View to match your 
work flow. Multiple Device View layouts can be created and saved.

To Open a BlackStorm Server Client:

1. In the DashBoard Tree View, expand the BlackStorm Server node and all of the nodes it contains.

2. In the Channels node, use one of the following methods to open Output Channel 1 in the Device View:

• Double-click the Output Channel 1 node.
• Right-click the Output Channel 1 node and select Open from the Shortcut menu.

Output Channel 1 opens in the Device View tab.
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3. In the Channels node, double-click the Output Channel 2 node.

Output Channel 2 opens in a second Device View tab, overlapping the Output Channel 1 tab.

4. In the Control Applications node, double-click the Media Manger node.

The Media Manager opens in a third Device View tab, overlapping the other open tabs.
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5. In the Control Applications node, double-click the Playlist Client node.

The Playlist Client opens in a third Device View tab, overlapping the other open tabs.

6. To access a BlackStorm Server Client, click the client tab at the top of the Device View.

BlackStorm Server Clients open in the Device View can be moved and resized to form a layout that enables all 
clients to be visible.

To Move a BlackStorm Server Client:

1. In the Device View, place the mouse pointer on the title bar of the BlackStorm Server Client (Media Manager 
Client) to move, then click and hold the mouse button.

2. Drag the selected BlackStorm Server Client to a new location in the Device View (left side).

As the client is dragged, a gray outline and an arrow preview the new location for the view.
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3. Release the mouse button to place the BlackStorm Server Client at the selected location.

4. Move the Output Channel 2 client to the top right corner of the Device View.
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5. Move the Output Channel 1 client to the left of the Output Channel 2 client in the Device View.

After moving the last BlackStorm Server Client, the layout of the Device View is as follows: 

Any of the BlackStorm Server Clients can be resized to fine-tune the layout.
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To Resize a BlackStorm Client:

1. In the Device View, place the mouse pointer on a border of the BlackStorm Server Client (Playlist Client) to 
move, then click and hold the mouse button.

2. To change the height of a BlackStorm Server Client (Play Client) in the Device View, place the mouse pointer 
on the top or bottom border of the client.

3. To change the width of a BlackStorm Server Client (Play Client) in the Device View, place the mouse pointer 
on the left or right border of the client.

Cursor position to change height

Cursor position to
change height
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4. When the mouse pointer changes to a double-headed arrow, click and drag the border to shrink or enlarge the 
BlackStorm Server Client.

5. Release the mouse button to set the size of the BlackStorm Server Client.

Click and drag to resize
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To Close a BlackStorm Server Client:

• In the tab of the BlackStorm Server Client to close, click Close (  ).

Saving a BlackStorm Client Layout
Once BlackStorm Server Client positions are set in the Device View, you can save the client layout. Each layout 
saves the DashBoard window state, size, and position. Layouts do not save client background and text color set 
using the Color Chooser dialog box.

To Save a BlackStorm Server Client Layout:

1. In DashBoard, use the View menu to select Save Layout.

The Save Current Layout dialog box opens.

2. In the Layout Name box, enter a name with which to save the current layout of the Device View.

3. Click OK.

For More Information on...
• restoring and managing layout, refer to the DashBoard User Guide.
• changing client background and text color, refer the chapter “Coloring BlackStorm Clients” on page 8–1
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Adding Media Items to a 
BlackStorm Server
Media items can be added to a BlackStorm Server by importing selected media items, or loading media items from 
the drop folder. The following clients are used to add and manage media items to a BlackStorm Server:

• Media Manager Client — import media files to a BlackStorm Server from any connected Client computer.
• Media Import Wizard — add media files to a BlackStorm Server from a selected folder.
• FTP — add or manage media files on a BlackStorm Server via an FTP client.

The following topics are discussed in this chapter:

• Loading Media Files through the Media Manager Client
• Using the Drop Folder to Load Media Files
• Importing Media Files from Selected Folders
• Managing Media Items

Ross recommends using the Media Manager Client or an FTP client to add media items to a BlackStorm 
Server. Adding files directly to the media directory is not supported and may result in a mismatch between the 
files system and the Media Manager.

Adding media items to a BlackStorm Server through the file system via the dropped folder is slower and less 
reliable in cases when large numbers of files are involved. Adding media items via the Media Import Wizard 
can result in lost data (such as trimpoints) if the current database is dropped.

Loading Media Files through the Media Manager Client
Media items can be added to a BlackStorm Server by loading the following types of media files created outside of 
the BlackStorm Server environment:

• QuickTime files (.MOV) — QuickTime Standard Definition (SD) and High Definition (HD) media items using 
the QuickTime Animation or the DV family of codecs can be played directly from a BlackStorm Server.

• Uncompressed Targa files (.TGA) — 24 and 32 bit files can be played directly from a BlackStorm Server.
• Run Length Encoded Targa files (.TGA) — 24 and 32 bit files can be played directly from a BlackStorm 

Server.

When importing Targa files, note the current BlackStorm video format and frame rate. Targa media items are 
only available for playout when the BlackStorm Server is running in the same format and frame rate as it was 
when the Targa files were imported onto the BlackStorm Server.

To import a media file onto the BlackStorm Server:

1. Use one of the following methods to launch the DashBoard software:

• Double-click the DashBoard icon on the desktop.
• Use the Start menu to select All Programs > DashBoard > DashBoard.

DashBoard opens.
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2. In the DashBoard Tree View, expand the BlackStorm Server node (  ).

The expanded BlackStorm Server node lists the available channels, applications, and tools.

3. Expand the Control Applications node (  ).

The expanded Control Applications node lists the available applications.

4. Double-click the Media Manager node (  ).

The Media Manager Client opens in the Device View.

Channel — click a 
channel panel to select 
the channel as the default 
channel to load media 
items from the Media 
Items or Current Bucket 
areas.

Folders — select from 
this tree view the folder 
containing the media 
items to load into 
channels.

Contents — this list 
displays the media items 
contained in the current 
bucket.

To Bucket — click this button 
to add the selected media 
items in the current bucket.

Details — click this button to 
view information about the 
selected media item in the 
Media Item Details dialog box.

Load — click this button to 
load the selected media item 
into the default channel.

Delete — click this 
button to delete the 
selected media item.

Name — click this button 
to display media item file 
names in the Media Items 
list.

Info — click this button to 
display media information 
and picture icons in the 
Media Items list.

Picon — click this button 
to display media item 
picture icons in the Media 
Items list.

Media Items — select 
from this list the media 
item to load into a 
channel, view information 
about, delete, or add to a 
bucket.

Status LEDs — these 
LEDs indicate the current 
status of the 
MediaManager Client 
connection with the 
BlackStorm Server and 
the Media Database.

Channel # — click a 
channel button to select 
the channel ast the default 
to load media items from 
the Media Items or Current
Bucket areas.

Sort — use this list to 
select the sort method for 
the Media Items list.

Filter — use this list to limit the 
media items shown in the 
Media Items list to those that 
contain a selected file type.

Bucket — use this list to 
select the bucket to add 
media items.
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5. Verify that the Server and Database LED icons are green, indicating that the Media Manager Client is 
connected to the BlackStorm Server and Media Database. If either LED icon is red, choose Server > Connect 
to reconnect with the BlackStorm Server and Media Database.

6. In the Media Items section, click the Directory tab.

7. Expand the folders in the Directory tree view to locate the folder in which to import a media file.

8. In the Directory tree view, right-click the import folder and select Import Content from the Shortcut menu.

The Select Source File dialog box opens showing the local file system of the computer running the DashBoard 
application.

9. Locate the media file to import onto the Media Manager Client, and then click Select Source File.

The selected media file is loaded onto the BlackStorm Server and added to the Media Database as a media 
item. The new media item is named the same as the media file, but without the file name extension.

Deleting Media Items

Deleting a media item from the BlackStorm Server removes the media item entry in the Media Database and deletes 
the associated media file from the BlackStorm Server. The Media Manager Client cannot delete the following types 
of media items:

• A media item that is on air.
• A playlist that is on air.

For More Information on...
• working with playlists, refer to the chapter “Working with Playlists” on page 7–1.

To delete a media item from a BlackStorm Server:

1. Open the Media Manager Client in the Device View.

2. In the Directory tab, use the Directory tree view to select the folder containing the media item or items to 
delete.

The Media Items list, to the right of the Directory tree view, displays the media items contained in the selected 
folder.

3. In the Media Item list, select the media item or items to delete.

4. Click Delete at the bottom of the Media Items list.

The Item Deletion dialog box opens.
BlackStorm Video Server User Guide (v1.1) Adding Media Items to a BlackStorm Server • 5–3



5. Click Yes.

The selected media item or items are deleted from the BlackStorm Server, and no longer exists in the Media 
Database. Deleted media items are also removed from any playlists in which they were contained.

On air media items or media items contained in an on air playlist cannot be deleted.

When the media item selected for deletion is contained one or more playlists, the Modify Playlists? alert 
opens. Click OK to delete the selected media item and remove it from the associated playlists. Click Cancel to 
keep the selected media item and leave the associated playlists unchanged.

When the media item or items selected for deletion are on air or contained in a playlist that is on air, the Media 
On Air dialog alert. Click OK to close the dialog box and keep the selected media item or items.

Exporting Media Files

A copy of the media file associated with a media item can be exported from the BlackStorm Server via the Media 
Manager Client to a folder in the local file system. Generally media files are exported from the Media Manager 
Client for editing or transfer to another system.

To export a copy of the media file associated with a media item to a folder in the local file system:

1. Open the Media Manager Client in the Device View.

2. In the Media Item list, locate the media item to export.
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3. Right-click the media item to export and select Export Content from the Shortcut menu.

The Select Destination Directory dialog box opens.

4. Locate and select the folder on the local file system in which to save a copy of the media file associated with 
the media item selected for export.

5. Click Select Destination Directory.

A copy of the media file associated with the selected media item is exported to the selected folder in the local 
file system.

Using the Drop Folder to Load Media Files
The Drop folder on the BlackStorm Server computer can be used to load supported media files onto a BlackStorm 
Server. All media files placed in the Drop folder are loaded onto the BlackStorm Server and added to the Media 
Database as individual media items. New media items are named the same as the loaded media file, but without the 
file name extension.

After loading a media file from the Drop folder onto the BlackStorm Server, replacing the media file in the Drop 
folder with a revised version of the same media file does not update the associated media item on the BlackStorm 
Server. The associated media item on the BlackStorm Server must be deleted before the revised media file can be 
loaded onto the BlackStorm Server.

Picons are not automatically generated for media items loaded onto the BlackStorm Server through the Drop 
folder.

To load media files onto a BlackStorm Server through the Drop folder:

1. Locally or remotely open the D:\Drop folder on the BlackStorm Server computer.

2. Copy the media files to load onto the BlackStorm Server into the D:\Drop folder.

The full path name of a media file placed in the Drop folder for loading onto the BlackStorm Server cannot be 
longer than 260 characters.

Media files added to the Drop folder are automatically loaded onto the BlackStorm Server and entered in the 
Media Database as a media item. All new media items are automatically added to the New Items bucket in the 
Media Manager.

3. Use the Media Manager to generate picons for the new media times.

For More Information on...
• deleting media items, refer to the section “Deleting Media Items” on page 5–3.
• accessing media items stored in buckets, refer to the section “Working with Media Item Buckets” on page 6–5.
• generating a picon for a media item, refer to the procedure “To generate a new picon for a media item:” on 

page 6–9.
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Importing Media Files from Selected Folders
The Media Import Wizard is used to load supported media files from one or more folders onto a BlackStorm Server. 
All of the media files in the selected folders are loaded onto the BlackStorm Server and added to the Media 
Database as individual media items. New media items are named the same as the loaded media file, but without the 
file name extension.

To import media files from a folder:

1. On the BlackStorm Server, use the Start menu to select All Programs > BlackStorm > Media Import.

The Media Import Wizard dialog box opens.

2. Click Add Folder.

The Browse for Folder dialog box opens.

Add Folder — click this button to use 
the Browse for Folder dialog box to 
select a folder from which to import 
clips or use as a watched folder.

Media Folder — root folder that stores 
media files added to the BlackStorm 
Server.

Additional Media Folders — this list 
displays the additional folders used to 
store media items.

Save Folders — click this button to 
save the folders in the Folders list as 
watched folders. The BlackStorm 
Server must be restarted to activate 
new watched folders.

Drop Media — select this check box to 
delete all media items from the Media 
Database before importing new media 
items to the Media Database.

Import — click this button to start 
importing media files into the Media 
Database from the listed folders.

Import Log — this area displays 
entries from the Import Log file.

Remove Folder — click this button to 
remove the selected folder from the 
Folders list.
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3. In the Folder tree view, locate the folder that contains the media files to import into the BlackStorm Server.

4. Click Open.

The Browse for Folder dialog box closes and the selected folder is added to the Folders list in the Media 
Import Wizard dialog box.

5. To import media files from additional folders, follow step 2 on page 5-6 to step 4 on page 5-7.

When using more than one folder to import media files, the names of all the media files contained in all of the 
folders must be unique. When two folders contain a media file with the same name, only the media file from the 
uppermost of the two folders in the Folder tree view will be imported. The media file in the lower folder is not 
imported since the BlackStorm Server already contains a media item with the same name as the media file.

Directories should only be added as import folders on the D: drive of the BlackStorm Server. Directories added 
from the C: driver or external storage are not guaranteed to have optimal performance.

6. If the Folders list contains unnecessary folders, do the following:

a. In the Folders list, select the unnecessary folders.

b. Click Remove.

c. For each selected folder, click OK to verify the removal of the folder from the Folders list.

7. Click Import.

All of the supported media files contained in the selected folders are import onto the BlackStorm Server. A 
media item is added to the Media Database for each imported media file. New media items are named the same 
as the imported media file, but without the file name extension. The Media Manager supports the Unicode 
character set to enable the entry, processing, and display of international characters for media item names.

8. Close the MediaImportApp dialog box.

Managing Media Items
A mapped FTP folder or an FTP client can be used to manage the media items on a BlackStorm Server. Media item 
management through FTP includes: loading media files, renaming media items, moving media items, deleting 
media items, creating media item folders, renaming media item folders, and deleting media item folders.

Mapped FTP Folder

By mapping the BlackStorm Server FTP server to a fold on a computer, media items can be managed using the 
Windows File Explorer. Managing media items through a mapped FTP folder is not supported on computers that 
use the Apple OS X operating system.
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To map the BlackStorm Server FTP server to a folder:

1. Log on to the computer from which to manage media items, the BlackStorm Server computer or a Client 
computer.

2. On the desktop, right-click the Computer icon and select Map Network Drive from the Shortcut menu.

The Map Network Drive dialog box opens.

3. Click on Connect To a Web site that you can use to Store your documents and pictures near the bottom of 
the dialog box.

The Add Network Location wizard opens.

4. Click Next.

The Where do you want to create this network location? screen opens.
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5. Select Choose a custom network location.

6. Click Next.

The Specify the location of your website screen opens.

7. Enter the following URL in the Internet or network address box, where Media-One is the hostname or IP 
address of your BlackStorm Server:

ftp://Media-One/Media 

Remember, URLs are case sensitive. Your Network Administrator can provide you with the hostname or IP 
address of your BlackStorm Server.

8. Click Next.

The Specify a User Name and Password if Required screen opens.

9. Clear the Log on anonymously check box.

10. Enter blackstorm in the User name box.
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11. Click Next.

The What do you want to name this location? screen opens.

12. Enter a name for the mapped FTP folder in the Type a name for this location box

13. Click Next.

The Completing the Add Network Location Wizard screen opens.

14. Clear the Open this network location when I click Finish check box.

15. Click Finish.

The Add Network Location wizard closes and the new mapped folder is added to the computer.

To manage media items through a mapped FTP folder:

1. Log on to the computer that contains a folder mapped to the Media folder on your BlackStorm Server.

2. On the desktop, double-click the Computer icon.

A File Explorer window opens for the computer.

3. In the File Explorer, locate the folder mapped to the Media folder on your BlackStorm Server.

4. Double-click the mapped folder.

A File Explorer window opens for the Media folder on your BlackStorm Server.
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5. In the open File Explorer, media items on the BlackStorm Server can be managed as follows:

• drag media files into the File Explored to load the media files onto the BlackStorm Server.
• rename media items on the BlackStorm Server.
• move media items between folders on the BlackStorm Server.
• delete media items from the BlackStorm Server.
• create new folders for media items on the BlackStorm Server.
• rename folders on the BlackStorm Server.
• delete folders from the BlackStorm Server.

Deleting a folder fold also deletes the media items contained in the folder.

FTP Client

An FTP client can be used to manage media items on a BlackStorm Server from computers running the Windows or 
Apple OS X operating systems.

The FileZilla FTP client can be used on computers running the Windows or Apple OS X operating systems. 
FileZilla FTP is free open-source software distributed under the terms of the GNU General Public License free of 
charge.

An FTP client used to manage files on a BlackStorm Server must support passive mode.

To manage media items through an FTP client:

1. Log on to the computer from which to manage media items, the BlackStorm Server computer or a Client 
computer.

2. Start your FTP client.

3. Use the following user name and password to log on to your BlackStorm Server FTP server:

• User name — blackstorm
• Password — blackstorm

4. Open the Media folder on the BlackStorm Server FTP server.

5. Use your FTP client to manage media items on the BlackStorm Server.

• upload media files to the BlackStorm Server.
• rename media items on the BlackStorm Server.
• move media items between folders on the BlackStorm Server.
• delete media items from the BlackStorm Server.
• create new folders for media items on the BlackStorm Server.
• rename folders on the BlackStorm Server.
• delete folders from the BlackStorm Server.

Deleting a folder fold also deletes the media items contained in the folder.
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Playing Media Items from a 
BlackStorm Server
The Media Manager and Play Clients provide the controls to play media items from a BlackStorm Server. The 
Media Manager Client can load and playout media items on up to two channels at the same time. Play Clients can 
be opened for each output channel on a BlackStorm Server.

Video output GenLock properties for the Media Manager and Play Clients are configured through the Configuration 
Client. In the Play Client, default playout properties can be overridden by loading play properties from a property 
file or changing play properties on the Configuration tab in the Play Client.

The following topics are discussed in this chapter:

• Playing Media Items
• Working with Media Item Buckets
• Custom Media Item Playout
• Viewing Multiple Timecodes in One Place

Playing Media Items
The Media Manager Client contains an interface to load media items and control media item playout from a 
BlackStorm Server. Each output channel on a BlackStorm Server has an associated Channel panel in the Media 
Manager Client. The media items loaded into the Channel panels are controlled individually.

To play a media item in the Media Manager Client:

1. Use one of the following methods to launch the DashBoard software:

• Double-click the DashBoard icon on the desktop.
• Use the Start menu to select All Programs > DashBoard > DashBoard.

DashBoard opens.

2. In the DashBoard Tree View, expand your BlackStorm Server node (  ).

The expanded BlackStorm Server node lists the available channels, applications, and tools.

3. Expand the Control Applications node (  ).

The expanded Control Applications node lists the available applications.
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4. Double-click the Media Manager node (  ).

The Media Manager Client opens in the Device View.

5. Verify that the Server and Database LED icons are green, indicating that the Media Manager Client is 
connected to the BlackStorm Server and Media Database.

6. In the Channels section, click the Channel from which to play out a media item.

The selected channel is highlighted in the Channels section.

7. In the Media Items section, click the Directory tab.

The Filter list can be used to limit the media items displayed in the Media Items list.

8. Expand the folders in the Directory tree view to locate and select the folder containing the media item to load 
into the selected Channel panel.

The media items contained in the selected folder are listed to the right of the Directory tree view.

9. Use the Sort list to select the method with which to sort the media items in Media Item list. The available sort 
methods are as follows:

• Sort by Name — alphabetical by media item name.
• Sort by Date — numerically by media item creation date.
• Sort by Name (case sensitive) — alphabetical by media item name, except list all media items that start 

with an uppercase letter before those that start with a lower case letter.

Channel — click a 
channel panel to select 
the channel as the default 
channel to load media 
items from the Media 
Items or Current Bucket 
areas.

Folders — select from 
this tree view the folder 
containing the media 
items to load into 
channels.

Contents — this list 
displays the media items 
contained in the current 
bucket.

To Bucket — click this button 
to add the selected media 
items in the current bucket.

Details — click this button to 
view information about the 
selected media item in the 
Media Item Details dialog box.

Load — click this button to 
load the selected media item 
into the default channel.

Delete — click this 
button to delete the 
selected media item.

Name — click this button 
to display media item file 
names in the Media Items 
list.

Info — click this button to 
display media information 
and picture icons in the 
Media Items list.

Picon — click this button 
to display media item 
picture icons in the Media 
Items list.

Media Items — select 
from this list the media 
item to load into a 
channel, view information 
about, delete, or add to a 
bucket.

Status LEDs — these 
LEDs indicate the current 
status of the 
MediaManager Client 
connection with the 
BlackStorm Server and 
the Media Database.

Channel # — click a 
channel button to select 
the channel ast the default 
to load media items from 
the Media Items or Current
Bucket areas.

Sort — use this list to 
select the sort method for 
the Media Items list.

Filter — use this list to limit the 
media items shown in the 
Media Items list to those that 
contain a selected file type.

Bucket — use this list to 
select the bucket to add 
media items.
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10. Use the Filter list to limit the media items displayed in the Media Items list. The Filter list contains the 
following file types:

• Video Filter (MOV) — list the media items that contain QuickTime (.mov) format video files.
• Video Filter (TGA) — list the media items that contain Targa (.tga) format image files or image file 

sequences.
• Video Filter (ALL Video) — list the media items that contain QuickTime (.mov) format video files or 

Targa (.tga) format image files.
• Video Filter (HD) — list the media items that contain video files in High Definition (HD) format.
• Video Filter (SD) — list the media items that contain video files in Standard Definition (SD) format.
• No Filter (ALL) — list all of the media items in a folder.
• PlayLists — list the all of the playlist media items on a BlackStorm Server.

11. Use the following buttons to select the information to display for the media items in the Media Item list.

•  — display media item file names.

•  — display media item information and picture icons.

•  — click this button to display media item picture icons and file names in the Media Items list. When 
this display option is selected, only the first 20 characters of the file name are displayed below the media 
item picture icon.

12. Use the Media Item list to select the media item to load into the selected channel.

The following types of media items can be expanded and collapsed:

• Playlist Media Items — the  icon indicates that a media item is a playlist.

Double-click the  icon to view the media items contained in the selected playlist. The selected playlist 
expands to display the media items contained in the playlist and the icon changes to . Double-click the 

icon to collapse the playlist to a single item.

• Targa Media Items — the  icon indicates that a media item is a Targa set.

Targa sets cannot be played out from the Media Manager, the Playlist Client must be used to playout Targa sets.

Double-click the  icon to view the Targa images contained in the selected Targa set. The selected Targa 
set expands to display the Targa images contained in the playlist and the icon changes to . Double-click 
the  icon to collapse the Targa set to a single item.

Targa media items are only available for playout when the BlackStorm Server is running in the same format and 
frame rate as it was when the Targa files were imported onto the BlackStorm Server.

13. To view details about the selected media item, click Details.

14. Click Load.

The selected media item is loaded into the selected channel and cued for playout. The loaded channel displays 
the media item picon, video file name, audio file name, and current status. The Media Manager Client can load 
and playout media items on up to two channels at the same time.
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15. Click the channel Play button to start playing the loaded media item. Each time this button is clicked, the state 
of the button changes as follows:

16. Use the Play button to control the playout of the media item.

To eject or unload a media item from a channel, drag the media item from the Channel and drop it on the 
Media Items list.

Double-click a media item in the Media Items list to quickly load the media item into the currently selected 
channel. Dragging a media item from the Media Items list and dropping it on a Channel panel in the Channel 
Control Area is another method that can be used to load a media item into a channel.

For More Information on...
• positioning BlackStorm Server clients in the DashBoard Device View, refer to the chapter “BlackStorm Server 

Client Layout” on page 4–1.

Playing Media Items that Contain an Embedded Alpha Channel

Media items that contain an embedded Alpha Channel require two channels for playout, channel 1 for the video and 
channel 2 for the alpha. Media items that contain an embedded Alpha Channel are only allowed to be loaded on 
Channel 1.

When using a BlackStorm Server with the Ross Video OverDrive production automation system, the OverDrive 
operator must be aware of which media items contain an embedded Alpha Channel. OverDrive does not warn the 
operator that channel 2 is not available after loading channel 1 with a media item that contains an embedded 
Alpha Channel.

To play a media item with an embedded Alpha Channel in the Media Manager Client:

1. Verify that the Server and Database LED icons are green, indicating that the Media Manager Client is 
connected to the BlackStorm Server and Media Database.

2. In the Media Manager Client, click Channel 1 the Channels section.

Channel 1 is selected and highlighted in the Channels section.

3. Use the Media Item list to select a media item with an embedded Alpha Channel to load into channel 1.

4. Click Load.

The video of the selected media item is loaded into channel 1 and the embedded Alpha Channel is loaded into 
channel 2. The media item is cued for playout. Channel 1 the Channels section displays the media item picon, 
video file name, audio file name, and current status.

One of the following alerts opens when an attempt is made to improperly load a media item with an embedded 
Alpha Channel.

• The Disallowed alert opens after attempting to load a media item with an embedded Alpha Channel on 
Channel 2.

• The Eject Channel 1 alert opens when an attempt is made to load a media item into channel 2 when a media 
item with an embedded Alpha Channel is loaded on channel 1.

5. Click the Channel 1 Play button to start playing the loaded media item with an embedded Alpha Channel.

Media Item State Play Button Click to...
Newly Loaded Start playing the media item.

Playing Pause the playing media 
item.

Paused Start playing the media item.
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Working with Media Item Buckets
Media item buckets are used to quickly access groups of often used media items stored in one or more folders. 
Media items can be loaded directly from a bucket into a channel by clicking the Load button or by dragging and 
dropping a media item from the bucket. The media items added to a bucket are automatically saved on the 
BlackStorm Server so that they can be accessed from the same bucket next time Media Manager Client is launched.

Playlists cannot be added to a bucket.

To create a bucket to hold media items:

1. In the Media Manager Client, click the Buckets tab.

The Buckets tab opens.

2. Click Create at the bottom of the Buckets tab.

The Create Bucket dialog box opens.

3. In the Enter Name box, enter a name for the new bucket.

The Media Manager supports the Unicode character set to enable the entry, processing, and display of 
international characters for bucket names.

4. Click OK.

The new bucket is added to the Buckets list in the Media Manager Client

Sort — use this list to 
select the sort method for 
the Media Items list.

Filter — use this list to limit the 
media items shown in the 
Media Items list to those that 
contain a selected file type.

Rename — click this 
button to use the Rename 
Bucket dialog box to 
change the name of the 
bucket selected in the 
Buckets list.

Create — click this button 
to use the Create Bucket 
dialog box to create a 
new bucket for media 
items.

Buckets — this list 
displays the available 
buckets.

Delete — click this button 
to delete the bucket 
selected in the Buckets 
list.

Name — click this button 
to display media item file 
names in the Media Items 
list.

Info — click this button to 
display media information 
and picture icons in the 
Media Items list.

Picon — click this button 
to display media item 
picture icons in the Media 
Items list.

Media Items — select 
from this list the media 
item to load into a 
channel, view information 
about, delete, or add to a 
bucket.

Status LEDs — these 
LEDs indicate the current 
status of the 
MediaManager Client 
connection with the 
BlackStorm Server and 
the Media Database.

Channel # — click a 
channel buttom to select 
the channel to load media 
items from the Media 
Items or Current Bucket 
areas.

Channel — click a 
channel panel to select 
the channel as the current 
channel to load media 
items from the Media 
Items or Current Bucket 
areas.

To Bucket — click this button 
to add the selected media 
items in the current bucket.

Details — click this button to 
view information about the 
selected media item in the 
Media Item Details dialog box.

Load — click this button to 
load the selected media item 
into the currently active 
channel.

Delete — click this 
button to delete the 
selected media item.
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To load media items into a bucket:

1. In the Media Manager Client, click the Directory tab.

The Directory tab opens.

2. Use the list in the Current Bucket section to select the name of the bucket to load media items.

3. Use the Directory tree view to select the folder containing the media items to load into the current bucket.

The media items contained in the selected folder are listed to the right of the Directory tree view.

4. Use the Media Item list to select the media item or items to load into the current bucket.

5. Click To Bucket.

The selected media items are loaded into the current bucket.

To load a channel from a bucket:

1. In the Channels section of the Media Manager, click the Channel panel on which to load a media item.

When the Channels section is hidden, use the Channel buttons to select the channel to load media items.

2. In the Media Items section, click the Directory tab.

3. Use the list in the Current Bucket section to select the name of the bucket containing the media item to load.

The media items contained in the selected bucket are listed in the Current Bucket section.

4. In the Current Bucket section, double-click the media item to load into the selected channel panel.

The selected media item is loaded onto the selected channel panel and cued for playout. A picon from and 
information about the loaded media item is displayed in the loaded channel panel.

Dragging a media item from the Current Bucket list and dropping it on a Channel is another method that can be 
used to load a media item from a bucket into a channel.

To delete media items from a bucket:

1. In the Media Manager Client, click the Buckets tab.

The Buckets tab opens.

2. Use the Bucket list to select the bucket from which to delete media items.

The media items contained in the selected bucket are listed in the Media Item list to the right of the Directory 
tree view.

3. Use the Media Item list to select the media item or items to delete from the current bucket.

4. Click Delete at the bottom of the Media Items list.

The Delete Selected dialog box opens.

5. Click Yes.

The selected media item or items are deleted from the current bucket, but still remain in the Media Database.

To rename a bucket:

1. In the Media Manager Client, click the Buckets tab.

The Buckets tab opens.

2. Use the Bucket list to select the bucket to rename.

3. Click Rename at the bottom of the Buckets tab.

The Rename Bucket dialog box opens.
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4. In the Enter Name box, enter a new name for the selected bucket.

The Media Manager supports the Unicode character set to enable the entry, processing, and display of 
international characters for bucket names.

5. Click OK.

The Bucket list is updated with the new name of the selected bucket.

To delete a bucket:

1. In the Media Manager Client, click the Buckets tab.

The Buckets tab opens.

2. Use the Bucket list to select the bucket to delete.

3. Click Delete at the bottom of the Buckets tab.

The Delete Bucket dialog box opens.

4. Click Yes.

The selected bucket is deleted from the Bucket list, but the media items in the bucket still remain in the Media 
Database.

Since buckets are saved on the BlackStorm Server, deleting a bucket also deletes it for all users working on the 
same BlackStorm Server.

Custom Media Item Playout
The Play Client can also be used to playout media items from a BlackStorm Server. Using the Play Client, media 
item playout can be customized as follows:

• Play from any point in a media item.
• Play only a portion of a media item.
• Loop the playout of a media item.
• Play a media item one frame at a time.

The Play Client must be used to playout Targa sets.

To control media item playout in the Play Client:

1. Open the Media Manager Client in the Device View.

2. In the DashBoard Tree View, expand your BlackStorm Server node (  ).

The expanded BlackStorm Server node lists the available channels, applications, and tools.

3. Expand the Channels node (  ).

The expanded Channels node lists the available output channels on the BlackStorm Server.
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4. Double-click the Output node for the output channel on which to playout a media item.

A Play Client opens in the Device View for the selected output channel.

5. Drag the media item to playout from the Media Manager Client to the Play Client.

The selected media item is loaded onto the output channel controlled by the Play Client.

Media items that contain an embedded Alpha Channel require two channels for playout, channel 1 for the video 
and channel 2 for the alpha. Media items that contain an embedded Alpha Channel are only allowed to be loaded 
on Channel 1.

6. Click Play in the playout controls along the bottom of the Play Client.

The Timecode displays the hours, minutes, seconds, and frames of the current position of the play head or the 
time remaining in the media item. The play head on the Timecode Progress Bar graphically indicates the 
current position of the play head in the media item. Use the View > Time Code Font Size command to set the 
size of the timecode numbers.

7. Click Pause in the playout controls.

Button Function
Play — play the media item. During media item playout, 
this button changes into the Pause button.

Button Function
Pause — pause the media item from the current state. 
Click the Play button to resume playing the media item.

Channel — use this list to 
select the channel from which 
to playout a media item.

Picon Viewer — this area 
displays a still image captured 
from a frame in the media item 
being played out.

Clip File Name — this field 
displays the name of the media 
item file selected on the 
BlackStorm Server for playout.

Timecode — this field displays 
the timecode of the play head 
position or the time remaining in a 
media item using the standard 
timecode format of 00:00:00:00 
(hours, minutes, seconds, frames)

In Point — this box displays the 
timecode of the media item In 
Point.

Out Point — this box displays 
the timecode of the media item 
Out Point.

Timecode Progress — use 
this bar to monitor and control 
media item playout.

Duration — this field displays 
the duration of the media item 
using the standard timecode 
format.

Playout Controls — use these 
buttons to control media Item 
playout.

Status LEDs — these LEDs 
indicate the current status of the 
Play Client connection with the 
BlackStorm Server and the 
Media Database.

Audio Meters — the two 
meters display real-time audio 
levels, in decibels, for the first 
two channels of audio 
associated with the media item 
being played out.
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8. Click Rewind to move the play head to the start of the media item, or click Fast Forward to move the play 
head to the end of the media item.

9. Click and drag the play head along the Timecode Progress Bar to advance or rewind to a specific point in a 
media item. To move the play head to a specific timecode:

a. Use the Media menu to select Jump to Timecode.

The Jump to Time code dialog box opens.

b. In the Timecode box, use the standard timecode format of 00:00:00:00 (hours, minutes, seconds, and 
frames) to enter the timecode at which to place the play head.

Do not enter timecodes that are less than the In Point or greater than the Out Point timecodes set for the 
media item.

c. Click Jump.

The play head moves to the enter timecode on the Timecode Progress Bar. The play head does not move 
when the entered timecode is less than the In Point or greater than the Out Point timecodes set for the 
media item.

10. After playing a media item, click Eject to unload the media item loaded in the current channel of the Play 
Client.

Use the Color Chooser dialog box to change the background and text color for each channel open in a Play 
Client. When using multiple channels on a BlackStorm Server, identifying each channel with a different color 
can be very helpful in enabling an operator to quickly differentiate between channels. For more information, 
refer to the chapter “Coloring BlackStorm Clients” on page 8–1.

To generate a new picon for a media item:

1. In the Media Manager, select the media item for which to generate a picon.

2. Load the selected media item into an open Play Client in the Device View.

3. Click Play to start playout of the loaded media item.

4. When the media item frame to use as the new picon displays on the monitor, click Pause.

5. Use the Media menu to select Generate Picon.

A new picon is generated for the media item from the paused frame, and displayed in the Picon Viewer. If the 
media item already had a picon, it is replaced with the newly generated picon.

Button Function
Rewind — rewind the media item to the In Point.

Fast Forward — fast forward the media item to the Out 
Point.

Button Function
Eject — unload the current media item from the Play 
Client.
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To set the In Point and Out Point to play a portion of a media item:

1. In the Media Manager, select the media item to playout.

2. Load the selected media item into an open Play Client in the Device View.

3. Use one of the following methods to adjust the In Point for the media item:

• Click and drag the In Point (green) marker along the Timecode Progress Bar to set the position of the 
media item In Point. The In Point Timecode box displays the timecode of the new In Point.

• Click the In Point Mark icon to the right of the In Point Timecode box to set the play head position as the 
media item In Point. The In Point (green) marker moves to the play head position on the Timecode 
Progress Bar and the In Point Timecode box displays the timecode of the new In Point.

• Use the Media > Jump to Timecode command to position the play head at an entered timecode. After 
positioning the play head, click the In Point Mark icon to the right of the In Point Timecode box to set the 
play head position as the media item In Point. The In Point (green) marker moves to the play head position 
on the Timecode Progress Bar.

The new In Point position is automatically saved with the media item.

4. Use one of the following methods to adjust the Out Point for the media item:

• Click and drag the Out Point (red) marker along the Timecode Progress Bar to set the position of the 
media item Out Point. The Out Point Timecode box displays the timecode of the new Out Point.

• Click the Out Point Mark icon to the right of the Out Point Timecode box to set the play head position as 
the media item Out Point. The Out Point (red) marker moves to the play head position on the Timecode 
Progress Bar and the Out Point Timecode box displays the timecode of the new Out Point.

• Use the Media > Jump to Timecode command to position the play head at an entered timecode. After 
positioning the play head, click the Out Point Mark icon to the right of the Out Point Timecode box to set 
the play head position as the media item Out Point. The Out Point (red) marker moves to the play head 
position on the Timecode Progress Bar.

The new Out Point is automatically saved with the media item.

5. Click Cue to cue the media item to the set In Point and ready it for playout.

6. Click Play in the playout controls to start playing the media item from the In Point and continue playing until 
the Out Point is reached or Pause is clicked.

Use the playout controls to control media item playout.

Button Function
Cue — return the play head to the In Point set for the 
media item. After cueing the media item, the Play Controls 
can be used to begin playout from the new In Point.

Out Point Timecode — enter 
in this box the timecode at 
which to place the Out Point.

Out Point Set — click this 
icon to set the Out Point to the 
timecode of the slider.

In Point Timecode — enter in 
this box the timecode at which 
to place the In Point.

In Point Set — click this icon 
to set the In Point to the 
timecode of the slider.

In Point — click and 
drag this marker to 
set the In Point.

Timecode Progress — use 
this bar to monitor and control 
media item playout.

Duration — this field displays 
the duration of the media item 
using the standard timecode 
format.

Out Point — click 
and drag this marker 
to set the Out Point.

Play Head — view and 
set the current position.
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To loop the playout of a media item:

1. In the Media Manager, select the media item to playout.

2. Load the selected media item into an open Play Client in the Device View.

3. Click Loop in the playout controls to start playing the media from the play head location and turn loop mode 
on.

4. When the loop mode is on, the arrows on the Loop button turn green. When the Loop button arrows are green, 
click Loop to turn off loop mode.

To view a media item one frame at a time to locate an exact frame:

1. In the Media Manager, select the media item to playout.

2. Load the selected media item into an open Play Client in the Device View.

3. Click Play in the playout controls to begin playing the media item.

4. At the point to start viewing the media item one frame at a time, click Pause in the playout controls.

5. Click Frame Forward in the playout controls to view the next frame in the media item, or Frame Back to 
view the previous frame in the media item.

For More Information on...

• playing out media items that contain an embedded Alpha Channel, refer to the section “Playing Media Items 
that Contain an Embedded Alpha Channel” on page 6–4.

Viewing Multiple Timecodes in One Place
The Timecode Client enables you to view timecodes from one or more of the following time sources in one place: 
House Time, Channel 1, Channel 2, Playlist Channel 1, and Playlist Channel 2

Time source timecodes are displayed in separate sections of the Timecode Client using the standard timecode 
format of 00:00:00:00 (hours, minutes, seconds, and frames). Time source sections can be added to, moved within, 
or removed from the Timecode Client as required.

Button Function
Loop — click to turn loop mode on. A playing media 
continues playout until the play head reaches the Out Point 
where it loops back to the In Point and restarts playout of 
the media item.
Looping playout continues until loop mode is turned off.

Button Function
Loop On — click to turn loop mode off. A playing media 
item continues playout until the play head reaches the Out 
Point and stops the playout.

Button Function
Frame Forward — move one frame forward in the media 
item.

Frame Back — move one frame backward in the media 
item.
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To view timecodes in the Timecode Client:

1. In the DashBoard Tree View, expand your BlackStorm Server node (  ).

The expanded BlackStorm Server node lists the available channels, applications, and tools.

2. Expand the Channels node (  ).

The expanded Channels node lists the available output channels on the BlackStorm Server.

3. Double-click the Timecode Client node (  ).

The Timecode Client opens in the Device View.

Each section in the Timecode Client displays the following timecodes for a time source:

• C — current time
• R — remaining time
• D — duration of the media item or playlist

One time code in each section is displayed in a larger font to highlight it from other two timecodes.

Customizing the Timecode Client Layout

The Timecode Client can be customized for your environment in the following ways:

• Change the highlighted timecode in a timecode source section.
• Add timecode source sections to the Timecode Client.
• Move timecode source sections within the Timecode Client.
• Remove timecode source sections from the Timecode Client.
• Compress the size of the Timecode Client.

Time Source — This field displays 
the name of time source connected 
to the timecodes displayed in the 
section.

Name — this field displays the 
name of the media item or playlist 
loaded on the time source.

Primary Timecode — this field 
displays the timecode of interest 
using the standard timecode format 
of 00:00:00:00 (hours, minutes, 
seconds, frames)

Secondary Timecodes — these 
fields display additional timecodes  
for a source using the standard 
timecode format of 00:00:00:00 
(hours, minutes, seconds, frames)
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To customize the layout of the Timecode Client:

1. To change the highlighted timecode in a section, click the section to rotate the timecodes in a clockwise 
direction.

2. To add a time source section to the Timecode Client, right click the section in the Timecode Client above 
which to add the new section and select one of the following commands from the Shortcut Menu:

• Add > House Time — add a House Time section.
• Add > Channel 1 — add a Channel 1 section.
• Add > Playlist Channel 1 — add a Playlist Channel 1 section.
• Add > Channel 2 — add a Channel 1 section.
• Add > Playlist Channel 2 — add a Playlist Channel 2 section.

The selected section is added to the Timecode Client above the selected section.

3. To move a section within the Timecode Client:

a. Place the mouse pointer on the section to move, then click and hold the mouse button.

b. Drag the section to a new position in the Timecode Client.

As the section is dragged, a red line previews the new location for the section.

c. Release the mouse button to place the section at the selected location.

4. To compress the size of the Timecode Client, right click the Timecode Client and select Compress View from 
the Shortcut Menu.

When the Timecode Client view is compressed, only the highlighted timecode is displayed for each section.

Click to highlight the 
Duration timecode

Click to highlight the 
Remaining timecode

Expanded View

Compressed View
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5. To view other timecodes in a compressed section, click the section to rotate through the available timecodes.

6. To expand a compressed Timecode Client, right click the Timecode Client and select Expanded View from 
the Shortcut Menu.
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Working with Playlists
The Playlist Client provides the controls to create and playout playlists. A playlist is a selection of custom-ordered 
media items that defines the following:

• The number of media items to playout
• The order of media item playout
• The portion of each media item to playout
• The method used to transition from the currently playing media item to the playout of the next media item.

Multiple playlist editors can be opened in the Playlist Client to create new playlists. For playout, the Playlist Client 
can open a playlist for each BlackStorm Server output channel. The Output Channel properties used by the Playlist 
Client are set on the GenLock tab in the Config Client.

The following topics are discussed in this chapter:

• Creating Playlists
• Editing Playlists
• Playing Out Playlists

Creating Playlists
The Playlist Client is used to create and edit playlists on air or off-line. Playlists are created from the media items 
stored in the Media Manager Client of a BlackStorm Server. Once created, a playlist is a media item.

Playlists can only contain media items that are stored on the same BlackStorm Server as the playlist.

To open a Playlist Client:

1. Use one of the following methods to launch the DashBoard software:

• Double-click the DashBoard icon on the desktop.
• Use the Start menu to select All Programs > DashBoard > DashBoard.

DashBoard opens.

2. In the DashBoard Tree View, expand your BlackStorm Server node (  ).

The available channels, applications, and tools are listed below the BlackStorm Server node.

3. Expand the Channels node (  ).

The available output channels are listed below the Channels node
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4. Double-click the Output 1 node (  ).

The Play Client for Output Channel 1 opens in the Device View.

5. Double-click the Output 2 node (  ).

The Play Client for Output Channel 2 opens in the Device View.

6. Expand the Control Applications node (  ).

The available control applications are listed below the Control Applications node

7. Double-click the Media Manager node (  ).

The Media Manager opens in the Device View.

8. Double-click the Playlist Client node (  ).

The Playlist Client opens in the Device View.

9. Position the Media Manager, Play Client, and Playlist Client so that all clients are visible in the Device 
View.

With the Media Manager, Play, and Playlist Clients positioned in the Device View, the work area is ready to 
create and use playlists.

For More Information on...
• positioning BlackStorm Clients in the Device View, refer to the chapter “BlackStorm Server Client Layout” on 

page 4–1.
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To create a playlist:

1. In the Playlist Client, use the File menu to select New Playlist.

The New Playlist dialog box opens.

2. In the Playlist Name box, enter a name for the new playlist.

The Playlist Client supports the Unicode character set to enable the entry, processing, and display of 
international characters for playlist names.

Playlist names cannot contain the % (percent) character.

3. Select one of the following options to specify the editor in which to create a new playlist:

• New Editor — select this option to open a new Playlist Editor in which to create a new playlist. The 
PlayList Editor is used to create playlists off-line.

• Channel 1 — select this option to create a new playlist on air in the Channel 1 panel of the Playlist Client. 
This option enables the immediate playout of the new playlist on Channel 1, but disables editing the on air 
(red background) and next (green background) media items.

• Channel 2 — select this option to create the new playlist on air in the Channel 2 panel of the Playlist 
Client. This option enables the immediate playout of the new playlist on Channel 2, but disables editing the 
on air (red background) and next (green background) media items.

4. Click OK.

The new playlist is automatically saved in the Media Manager as media item. Depending on the selected 
playlist editor, either a new Editor panel opens or the name of the playlist is added to the selected Channel 
panel.

5. Use the Media Manager Client to list the available media items that can be added to a playlist.

Playlist Name
Playlist Duration Playlist Duration

On Air Media Item 
Remaining Time 

Playlist Name

New Playlist in a Play List Editor New Playlist in a Channel Panel
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6. In the Media Manager Client, click and drag media items or playlists from the Media Item list into an open 
playlist Editor panel or Channel panel. A playlist may contain a maximum of 300 media items. Playlists are 
automatically saved as media items are added.

A playlist can only contain media items that are encoded with the same video format and frame rate. Also, 
playlists cannot contain a mixture of media items with alpha channels and no alpha channels.

When a TGA sequence media item is added to a playlist, only the individual TGA media items in the TGA 
sequence are added to the playlist. Changes made to the original TGA sequence media item do not affect the 
TGA media items added to the playlist.

When a playlist is added to another playlist, only the media items in the selected playlist are added to the other 
playlist. Changes made to the original playlist do not affect the media items added to the other playlist.

Editing Playlists
After a playlist is added to a BlackStorm Server, the following changes can be made to the playlist:

• Add media items to a playlist.
• Move media items in a playlist.
• Delete media items from a playlist.
• Set the portion of a media item to playout.
• Set the action performed when a media item finishes playout.
• Set the method used to transition between media items.

The Editor panel or a Channel panel in the Playlist Client can be used to edit a playlist. The Editor panel enables 
off-line editing of a playlist. A Channel panel enables playlist editing during playout, but disables editing the On 
Air (red) or Next (green) media items. Editing a media item is automatically disabled when the media item becomes 
the Next (green) or On Air (red) media item.

The Playlist Client does not restrict multiple users from editing a playlist. Playlist editing should be restricted to 
a single user and a single Edit or Channel panel in the Playlist Client.

Media items in the Edit panel Media items in the Channel panel
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To add a media item to a playlist:

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or 
Channel panel of the Playlist Client.

The media items contained in the selected playlist are displayed in the Playlist Client.

2. Click and drag a media item from the Media Manager Client into the playlist open in an Editor panel or 
Channel panel.

A playlist can only contain media items that are encoded with the same video format and frame rate. Also, 
playlists cannot contain a mixture of media items with alpha channels and no alpha channels.

3. Move the pointer to the position in the playlist to add the selected media item.

A black bar indicates the selected playlist position for the new media item.

Playlist loaded in the Edit panel Playlist loaded in a Channel panel
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4. Release the mouse button to add the media item to the playlist at the selected position.

The added media item is displayed in the playlist at the selected position, and the updated playlist is 
automatically saved.

When an existing playlist is added to a new playlist, only the media items contained in the existing playlist are 
added to the new playlist. Changes made to the original playlist do not affect the media items added to the new 
playlist.

To move a media item in a playlist:

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or 
Channel panel of the Playlist Client.

The media items contained in the selected playlist are displayed in the Playlist Client.

2. In the playlist, click and drag the media item to move.

3. Place the pointer in the playlist at the new position for the selected media item.

A black bar indicates the new playlist position for the media item.

4. Release the mouse button to place the media item at the selected location in the playlist.

The moved media item is displayed in the playlist at the new location, and the updated playlist is automatically 
saved.

To delete media items from a playlist:

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or 
Channel panel of the Playlist Client.

The media items contained in the selected playlist are displayed in the Playlist Client.

2. In the playlist, right-click the media item to delete from the playlist and select Delete from the Shortcut menu.

The selected media item is deleted from the playlist, but not deleted from the BlackStorm Server.

Media items deleted through the Media Manager or FTP are also removed from any playlists in which they were 
contained.
7–6 • Working with Playlists BlackStorm Video Server User Guide (v1.1)



To set the In Point and Out Point to play a portion of a media item:

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or 
Channel panel of the Playlist Client.

The media items contained in the selected playlist are displayed in the Playlist Client.

2. In the playlist, double-click the media item to edit.

The background color of the selected media item turns tan to indicate that the media item is in Edit mode.

When editing a playlist in a Channel panel, the On Air (red) and Next (green) media items in a playlist cannot 
be edited.

3. In the In Point box, enter the timecode at which to start playing the media item.

Timecodes are entered as hours, minutes, seconds, and frames. Entered timecodes are automatically saved with 
the playlist and do not affect media items when played outside of the playlist.

4. In the Out Point box, enter the timecode at which to stop playing the media item.

When the media item is played out as part of the playlist, only the portion of the media item from the set In 
Point timecode to the set Out Point timecode plays out.

5. Press Enter to save timecode changes, or press ESC to discard the changes.

The background color of the media item returns to the default color.

To set the action and transition performed when a media item finishes playout:

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or 
Channel panel of the Playlist Client.

The media items contained in the selected playlist are displayed in the Playlist Client.

2. In the playlist, double-click the media item to edit.

The background color of the selected media item turns tan to indicate that it is in Edit mode.
BlackStorm Video Server User Guide (v1.1) Working with Playlists • 7–7



3. Use the End Action list to select the action to perform when playlist playout reaches the Out Point of the 
selected media item. The available actions are as follows:

• X-Fade — gradually transition playout from the playing media item to the next media item in the playlist. 
Use the list to the right to select the number of frames in which to complete the transition.
This end action applies the set transition duration to the current and next media items in the playlist. For 
example: for a set duration of 30 frames, the transition uses 30 frames from each media item. This end action 
is ignored when the transition length is equal or longer than the current or next media item in the playlist.

• V-Fade — gradually transition playout from the playing media item to black followed by a gradual 
transition from black to the next media item in the playlist. Use the list to the right to select the number of 
frames in which to complete the transition.
This end action applies half of the set transition duration to the current and next media items in the playlist. 
For example: for a set duration of 30 frames, the transition uses 15 frames from each media item. This end 
action is ignored when the transition length is equal or longer than the current or next media item in the 
playlist.

• V-Fade with Pause — gradually transition playout from the playing media item to black followed by a 
gradual transition from black to the next media item in the playlist, then pause playlist playout. Use the list 
to the right to select the number of frames in which to complete the transition.
This end action applies half of the set transition duration to the current and next media items in the playlist. 
For example: for a set duration of 30 frames, the transition uses 15 frames from each media item. This end 
action is ignored when the transition length is equal or longer than the current or next media item in the 
playlist.

• Play Next — instantaneously switch playout from the playing media item to next media item in the playlist, 
or pause playout of the playlist.

• Pause — pause playlist playout.
• Hold, Cue, Pause — hold playout on the last frame of the current media item for a set number of frames, 

cue the next media item in the playlist, then pause the media item on the first frame of video. Use the list to 
the right to select the number of frames to hold on the last frame of the current media item. During the hold, 
the BlackStorm Server plays out the last frame of the current media item.
When using this end action:
› The set hold interval adds to the playlist length.
› The set hold interval does not change the reported media item length.
› When a media item is cued and paused, clicking Step to next and Play in the Playlist Client ignores the 

current media item end action and advances to the media item in the playlist.
› This end action works when the playlist is initiated from an external controller. The playlist continues 

after receiving the next play command from the external controller (AMP and VDCP).
› If a Play command arrives from an external controller during the hold, it ends the hold and advances to 

the cued media item.
› If a Pause command arrives from an external controller during the hold, a Continue command will 

resume the hold for the remaining time. An Advance command cues and then pauses the medial item.

The selected actions are automatically saved with the playlist and do not affect the media item when played 
outside of the playlist.

Changing End Action span times, In Points, Out Points, or media item durations so that there is overlap in End 
Actions from one media item to another, may result in unexpected video changes during the overlap of End 
Action times.

4. Press Enter to save action and transition changes, or press ESC to discard the changes.

The background color of the media item returns to the default color.
7–8 • Working with Playlists BlackStorm Video Server User Guide (v1.1)



Targa Duration

When a Targa file is placed in a playlist, a number of frames can be set to keep the Targa file on a channel before 
playing out the next media item in the playlist.

1. In the Media Manager, click and drag the playlist to edit from the Media Item list into an open Editor or 
Channel panel of the Playlist Client.

2. In the playlist, double-click the added Targa file to edit.

The background color of the Targa file turns tan to indicate that the media item is in Edit mode.

When editing a playlist in a Channel panel, the On Air (red) and Next (green) media items in a playlist cannot 
be edited.

3. In the Duration box, enter the number of frames to keep the Targa file on a channel before playing out the next 
media item in the playlist.

Entered durations are automatically saved with the playlist and do not affect the Targa file when played outside 
of the playlist.

4. Press Enter to save timecode changes, or press ESC to discard the changes.

The background color of the media item returns to the default color. The entered number of frame is converted 
to a standard timecode (hours, minutes, seconds, and frames) and displayed in the Out box. The playlist 
duration is also updated with the duration set for the Targa file.

Playing Out Playlists
Playlists can be played out from the Media Manager, Play, or Playlist Client. Only the Playlist Client can be used to 
edit the on air playlist.

When using a BlackStorm Server with the Ross Video OverDrive production automation system, the OverDrive 
operator must be aware of which playlists contains media items with an embedded Alpha Channel. OverDrive 
does not warn the operator that channel 2 is not available after loading channel 1 with a playlist that contains one 
or more media items with an embedded Alpha Channel.
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To playout a playlist:

1. In DashBoard, position the Media Manager, Output Channels, and Playlist Client so that all clients are 
visible in the Device View. Refer to step 9 on page 7-2 for an example client layout.

2. In the Directory tab of the Media Manager Client, use the Filter list to select PlayLists. Playlists on the 
BlackStorm Server are displayed in the Media Items list with the  icon.

3. Double-click the  icon to view the media items contained in the selected playlist.

The selected media item expands to display the media items contained in the playlist and the icon changes to 
. Double-click the  icon to collapse the playlist to a single item.

4. Use one of the following methods to load a playlist into a channel.

• Use the Media Manager Client to select a media item and load it into a channel.
• Drag a media item from the Media Manager Client to an open Output Channel panel in the 
• Drag a media item from the Media Manager Client to a Channel panel in the Playlist Client.

Playlists that contain media items with an embedded Alpha Channel require two channels for playout, channel 1 
for the video and channel 2 for the alpha. Only Channel 1 can be used to playout a playlist that contains one or 
more media items with an embedded Alpha Channel.

5. Use one of the following methods to start playout of the loaded playlist.

• In the Media Manager Client, click Play in the channel that contains the loaded playlist.
• In the Output Channel panel that contains the loaded playlist, click Play.
• In the Playlist Client, right-click the first media item in the loaded playlist and select Play Now from the 

Shortcut menu.

The first media item in the playlist starts playing out on the loaded channel of the BlackStorm Server. In the 
Playlist Client the background of the on air media item is shaded red and the background of the next media 
item to go on air is shaded green.

On Air Media Item

Playlist Controls

Next Media Item

Playlist Media Items

“On Air” and “Next” Media Items Shown Hidden “On Air” and “Next” Media Items
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6. To cue a playlist to a selected media item in the playlist, right-click a media item and select Cue Now from the 
Shortcut menu.

The playlist is cued to the selected media item. To start playout from the cued media item, click Play in the 
Media Manager or Play Client channel that contains the loaded playlist.

7. To start playout of a selected media item in the playlist, right-click a media item and select Play Now from the 
Shortcut menu.

Playout of the playlist continues from the selected media item.

8. To select a media item as the next media item to play, right-click a media item and select Set to Play Next from 
the Shortcut menu.

After playout of the currently playing media item finishes, playout of the playlist continues with the selected 
media item.

9. Select the Show “On Air” and “Next” clip command from the View menu to toggle the display of the on air 
and next media items around the Playlist Controls.

10. During playout, the Playlist section automatically scrolls to display the on air media item at the top of the 
section.

The Playlist section scroll bar can be used to view media items that are not visible in the Playlist section. 
Automatic scrolling of the Playlist section stops when the on air and next media items are not visible the 
section.

11. To view the on air media item in the Playlist section, click Jump to Live (  ) in the Playlist Controls to 
scroll the on air media item to the top of the Playlist section and resume automatic scrolling of the section.

To control a playlist during playout:

1. All of the controls in an Output Channel panel can be used to control playout of the loaded playlist.

2. Each Channel panel in the Playout Client contains the following playlist controls:

3. During playlist playout, playlist media items can be edited with the exception of the on air and next media 
items. The Channel panel of the Playlist Client can be used to perform the following procedures to edit a 
playlist during playout:

• “To add a media item to a playlist:” on page 7–5
• “To move a media item in a playlist:” on page 7–6
• “To delete media items from a playlist:” on page 7–6
• “To set the In Point and Out Point to play a portion of a media item:” on page 7–7
• “To set the action and transition performed when a media item finishes playout:” on page 7–7

Button Function
Step to Next and Play — click this button to put the next 
media item in the playlist on air and start media item 
playout.

Step to Next — click this button to put the next media 
item in the playlist on air. This button does not start media 
item playout.

Eject — click this button to eject the playlist from the 
current channel.

Jump to Live — click this button to scroll the on air 
media item to the top of the Playlist section and resume 
automatic scrolling of the section.
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For More Information on...
• Output Channel controls, refer to the section “Playing Media Items” on page 6–1.
• editing playlists, refer to the section “Editing Playlists” on page 7–4.
• deleting playlist, refer to the procedure “To delete media items from a playlist:” on page 7–6
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Coloring BlackStorm Clients
The Color Chooser dialog box is used to independently change the background and text color for each open Media 
Manager, Play, or Playlist Client. When using multiple channels on a BlackStorm Server, identifying each channel 
with a different color can be very helpful in enabling an operator to quickly differentiate between channels and 
clients. For example, you can select red for channel 1, green for channel 2, yellow for the Media Manager Client, 
and blue for the Playlist Client.

Figure 8.1  Colored Clients

The following topics are discussed in this chapter:

• Client Background and Text Colors
• Customizing Colors

Client Background and Text Colors
The background and/or the color of text used to label sections and tabs can be uniquely set for any open Media 
Manager, Play, or Playlist Client.
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To change the background or text color of an open Client:

1. In an open Media Manager, Play Client, or Playlist Client select one of the following commands from the 
View menu:

• Background Color — Change the color of the background using the Choose Background Color dialog 
box.

• Foreground Color — Change the color of the text using the Choose Foreground Color dialog box.

The Color Chooser dialog box associated with the selected command opens.

2. In the Swatches tab, click the square that contains the color to use for the background or text. Click the Reset 
button to return to the default color.

3. In the Preview section, verify how the selected color scheme will look.

4. Click OK to apply the selected color and close the Choose Color dialog box.

Customizing Colors
In addition to the predefined colors on the Swatch tab in the Choose Color dialog boxes, it is also possible to define 
custom colors using one of the following methods:

• HSB — Hue, Saturation, and Brightness
• RGB — Red, Green, Blue

Defining a Color Using HSB

When defining colors using HSB values, the values are set as follows:

• Hue — the location of a color in the spectrum. The spectrum is divided into six basic hues: red, yellow, blue, 
orange, green, and purple.

• Saturation — the intensity of a color within the spectrum. The less gray in a color, the more saturated it appears.
• Brightness — the intensity which light reflects from or transmits through a color.
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To use HSB values to define custom background or text colors:

1. In an open Media Manager, Play Client, or Playlist Client, select one of the following commands from the 
View menu:

• Background Color — change the color of the background using the Choose Background Color dialog 
box.

• Foreground Color — change the color of the text using the Choose Foreground Color dialog box.

The Color Chooser dialog box associated with the selected command opens.

2. Click the HSB tab.

The HSB tab opens.

3. Select the H option, then set the hue for the new color using one of the following methods:

• Drag the slider up or down the hue scale.
• Enter or select a hue value in the box to the right of the H option.

4. Select the S option, then set the saturation for the new color using one of the following methods:

• Drag the slider up or down the saturation scale.
• Enter or select a saturation value in the box to the right of the S option.

5. Select the B option, then adjust the brightness of the new color using one of the following methods:

• Drag the slider up or down the brightness scale.
• Enter or select a brightness value in the box to the right of the B option.

6. In the Preview section, verify how the new color will look.

7. Click OK to apply the new color and close the Choose Color dialog box.

After setting a hue, saturation, or brightness value, select the new color from the Color Square. The selected point 
in the Color Square sets the remaining values for the new color.

Defining a Color Using RGB

When defining colors using RGB values, the values are set as follows:

• Red — the level of red in the defined color.
• Green — the level of green in the defined color.
• Blue — the level of blue in the defined color.
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To use RGB values to define custom background or text colors:

1. In an open Media Manager, Play Client, or Playlist Client, select one of the following commands from the 
View menu:

• Background Color — Change the color of the background using the Choose Background Color dialog 
box.

• Foreground Color — Change the color of the text using the Choose Foreground Color dialog box.

The Color Chooser dialog box associated with the selected command opens.

2. Click the RGB tab.

The RGB tab opens.

3. Set the level of red in the new color using one of the following methods:

• Drag the slider along Red scale. The red level value is displayed in the box the right of the Red scale.
• Enter or select a value for the red level in the box to the right of the Red scale.

4. Set the level of green in the new color using one of the following methods:

• Drag the slider along Green scale. The green level value is displayed in the box the right of the Green scale.
• Enter or select a value for the green level in the box to the right of the Green scale.

5. Set the level of blue in the new color using one of the following methods:

• Drag the slider along Blue scale. The blue level value is displayed in the box the right of the Blue scale.
• Enter or select a value for the blue level in the box to the right of the Blue scale.

6. In the Preview section, verify how the new color will look.

7. Click OK to apply the new color and close the Choose Color dialog box.
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Appendix A. Specifications
This appendix describes basic properties of the BlackStorm Server, including specifications, capabilities, and 
specific conventions that should be followed when using the BlackStorm Server.

The following topics are discussed in this appendix:

• Media Formats and Codecs
• VDCP Commands for the BlackStorm Server
• Communication Serial Port

Media Formats and Codecs
The BlackStorm Server supports the following media formats and codecs for playout.

Media File Formats

The following video media formats are supported by the BlackStorm Server:

• QuickTime files (.MOV) — QuickTime Standard Definition (SD) and High Definition (HD) media items using 
the QuickTime Animation or DV codec can be played directly from a BlackStorm Server.

• Uncompressed Targa files (.TGA) — 24 and 32 bit files can be played directly from a BlackStorm Server.
• Run Length Encoded Targa files (.TGA) — 24 and 32 bit files can be played directly from a BlackStorm 

Server.

The following audio media formats are supported by the BlackStorm Server:

• Interleaved — 48 KHz x 16, 24, or 32 bit audio inteleaved in a video file.

Codecs

The following codecs in MOV format are supported by the BlackStorm Server:
Table 9.1  BlackStorm Server Native Codecs

Codec Format Bitrate Hours / TB
DV, DVCAM, DVCPRO SD 25 82

DVCPRO 50 SD 50 43

QUICKTIME ANIMATION SD

DVCPRO HD HD 100 22

QUICKTIME ANIMATION HD
BlackStorm Video Server User Guide (v1.1) Appendix A. Specifications • 9–1



VDCP Commands for the BlackStorm Server
The Video Disk Communications Protocol (VDCP) is a tightly-coupled master/slave communication method based 
on the RS-422 signal standards. The controlling device initiates communication between itself and the controlled 
device. This protocol also conforms to the Open Systems Interconnect (OSI) reference model.

The BlackStorm Server responds to the following commands under VDCP control:
Table 9.2  Supported VDCP Commands

Command From Controller Return from Controlled Disk
CMD-1 CMD-2 Name CMD-1 CMD-2 Name

1X 00 Stop 04 ACK

1X 01 Play 04 ACK

1X 04 Still 04 ACK

1X 05 Step 04 ACK

1X 06 Continue 04 ACK

1X 07 Jog 04 ACK

1X 08 Variable Play 04 ACK

2X / AX ID Rename ID 04 ACK

2X 21 Close Port 04 ACK

2X 22 Select Port 04 ACK

2X / AX 24 Play Cue 04 ACK

2X / AX 25 Cue with Data 04 ACK

2X / AX 26 Delete ID 04 ACK

3X 01 Open Port 3X 81 Grant/Denied

3X / BX 02 Next 3X 82 List of IDs

3X / BX 03 Last 3X 83 Last Response

3X 05 Port Status Request 3X 85 State Status

3X 06, Position Request 3X 86 Position

3X / BX 07 Active ID Request 3X 87 Active ID

3X 08 Device Type Request 3X 88 Device Type

3X 10 System Status Request 3X 90 System Status

3X / BX 11 ID List 3X 91 List of IDs

3X / BX 14 ID Size Request 3X 94 ID Size

3X / BX 15 IDs Added to Arch. 3X 95 List IDs Trans.

3X / BX 16 ID Request 3X 96 ID Presence

3X / BX 18 IDs Added List 3X 98 List IDs Added

3X / BX 19 IDs Deleted List 3X 99 List IDs Deleted
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Communication Serial Port
The pinouts for the serial communication ports (Com3 and Com4) in the breakout cable attached to the rear of a 
BlackStorm Server are as follows:

Figure 9.1  BlackStorm Server RS-422 Male DB9 Serial Communication Port (Com 3 and Com 4)

Use the following information to create an RS-422 serial interface cable (Male DB9 to Male DB9) to connect a 
Ross Video switcher to BlackStorm Server.

Figure 9.2  RS-422 DB9 Serial Communication Cable Connectors

Table 9.3  BlackStorm Server Serial Communication Port Pinouts

Pin # Signal
1 Ground

2 RxD-

3 TxD+

4 Ground

5 Not Connected

6 Ground

7 RxD+

8 TxD-

7 Ground

Table 9.4  RS-422 DB9 Serial Communication Cable Pinouts

To Switcher To BlackStorm Server 
Signal Pin # Pin # Signal

Not Connected 1

RxD- 2 8 TxD-

TxD+ 3 7 RxD+

Not Connected 4

Ground 5 1, 4, 6, 9 Ground

Not Connected 6

RxD+ 7 3 TxD+

TxD- 8 2 RxD-

Not Connected 7

543
76

21
98

To BlackStorm ServerTo Switcher

543
76

21
98

123
89

45
67

Male Connector on Cable Female Connector on Cable
BlackStorm Video Server User Guide (v1.1) Appendix A. Specifications • 9–3



9–4 • Appendix A. Specifications BlackStorm Video Server User Guide (v1.1)



Index
A

Alpha Channel ................................................ 6-4
Ancillary Time Code (ATC) ......................... 3-11
Audio Format .................................................. 9-1

B
Background Color

blue level ...................................................... 8-4
brightness ..................................................... 8-3
green level .................................................... 8-4
hue................................................................ 8-3
red level........................................................ 8-4
saturation...................................................... 8-3

Browse
import folder ................................................ 5-6

Buckets............................................................ 6-5
adding media items ...................................... 6-6
creating......................................................... 6-5
deleting......................................................... 6-7
deleting media items .................................... 6-6
loading channels........................................... 6-6
renaming ...................................................... 6-6

C
Channels

loading.......................................................... 6-3
loading from buckets.................................... 6-6
naming.......................................................... 3-6

Client Software
installation.................................................... 2-2
update ........................................................... 2-2
usage ............................................................ 2-1

Clients
Configuration ............................................... 3-1
Media Manager ............................................ 5-2
moving ......................................................... 4-5
opening......................................................... 4-2
Play .......................................................6-7, 6-8
Playlist.......................................................... 7-1
resizing ......................................................... 4-8
Timecode.................................................... 6-12

Codecs............................................................. 9-1
Color Chooser

background color ......................................... 8-2

blue level.......................................................8-4
brightness......................................................8-3
foreground color ...........................................8-2
green level.....................................................8-4
hue ................................................................8-3
opening .........................................................8-2
red level ........................................................8-4
saturation ......................................................8-3

Configuration Client
opening .........................................................3-4
tabs

Channel Name ...........................................3-6
Channel Time...........................................3-11
GenLock ....................................................3-7
House Time..............................................3-10
Remote Control..........................................3-8

Configuring
information logs............................................3-6
output resolution ...........................................3-7

Connections
network .........................................................3-2
status .............................................................4-2

Creating
buckets ..........................................................6-5
playlist ..........................................................7-1

Cueing
media items.................................................6-10

D

DashBoard .......................................................2-3
configure for clients......................................2-3
opening .........................................................3-4

Database
Service ........................................................2-16

Deleting
buckets ..........................................................6-7
media item ....................................................5-3
media items from buckets.............................6-6

Documentation Conventions ...........................1-2
Drop Folder .....................................................5-5

E
Export

media item ....................................................5-4
BlackStorm Video Server User Guide (v1.1) Index • 1



F
Files

MOV............................................................. 9-1
QuickTime.................................................... 9-1
Targa ............................................................. 9-1
TGA.............................................................. 9-1

Firewall
configuration ................................................ 3-3

Firmware
AJA card version

check........................................................ 2-13
update ...................................................... 2-13

Folders
drop............................................................... 5-5
import ........................................................... 5-6

Formats
audio ............................................................. 9-1
codecs ........................................................... 9-1
media ............................................................ 9-1
video ............................................................. 9-1

G

GenLock.......................................................... 3-7
Getting Help .................................................... 1-2

I
Import

drop folder .................................................... 5-5
media items from folders.............................. 5-6
Media Manager ............................................ 5-1

In Point
media item .................................................. 6-10

Installing
client software ...................................... 2-2, 2-7
server software ........................................... 2-11

International Characters .................................. 1-1

L
LED

connection status .......................................... 4-2
genlock status ............................................... 3-7

Linear Timecode (LTC)....................... 3-10, 3-11
Logs................................................................. 3-6
Loop .............................................................. 6-11

M

Media Item ...................................................... 5-1
alpha channel................................................ 6-4

deleting..........................................................5-3
deleting from buckets....................................6-6
exporting .......................................................5-4
importing from folders..................................5-6
In Point........................................................6-10
loading...........................................................5-1
Out Point .....................................................6-10
picon..............................................................6-8
selecting ........................................................6-3

Media Manager Client
opening..........................................................5-2
playout controls.............................................6-4
tabs

Buckets.......................................................6-5
Directory ....................................................6-2

N

Network Configuration ....................................3-4
Network Connections ......................................3-2
Network Time Protocol (NTP) server............3-10

O
Opening

clients ............................................................4-2
Color Chooser ...............................................8-2
Configuration Client .....................................3-4
DashBoard.....................................................3-4
Media Manager Client ..................................5-2

Out Point
media item...................................................6-10

Output Channel
resolution.......................................................3-7
selecting ........................................................6-2

P
Picon

generation......................................................6-9
media item.....................................................6-8

Play Client
media item picon...........................................6-8
playout controls.............................................6-8

Playlist
add media item..............................................7-5
alpha channel ..............................................7-10
client..............................................................7-3
create .............................................................7-1
creating..........................................................7-3
delete media item ..........................................7-6
editing ...........................................................7-4
2 • Index BlackStorm Video Server User Guide (v1.1)



end action and transition .............................. 7-7
playout.......................................................... 7-9
re-order......................................................... 7-6
trim points .................................................... 7-7

Playout
advanced ...................................................... 6-7
loop ............................................................ 6-11
one frame at a time..................................... 6-11
playlist.......................................................... 7-9
portion of a media item .............................. 6-10

Playout Controls
Media Manager Client ................................. 6-4
Play Client.................................................... 6-8

Q

QuickTime ...................................................... 9-1

R
RGB Levels

blue............................................................... 8-4
green............................................................. 8-4
red ................................................................ 8-4

S
Selecting

background color ......................................... 8-2
foreground color........................................... 8-2
media items .................................................. 6-3
output channel .............................................. 6-2

Server
software uninstall ....................................... 2-15
software update .......................................... 2-11

Services ......................................................... 2-16
Start ............................................................ 2-17
Stop ............................................................ 2-17

Settings
firewall ......................................................... 3-3
network ........................................................ 3-4

Software
client update ................................................. 2-2
install clients ................................................ 2-7
installing clients ........................................... 2-2
server uninstall ........................................... 2-15
server update .............................................. 2-11
uninstall ...................................................... 2-15

System Requirements
hardware....................................................... 2-2
software........................................................ 2-2

T
Tabs

Buckets .........................................................6-5
Channel Name ..............................................3-6
Channel Time..............................................3-11
Directory.......................................................6-2
GenLock .......................................................3-7
House Time.................................................3-10
Remote Control.............................................3-8

Targa ................................................................9-1
duration.........................................................7-9

Technical Support ............................................1-3
Timecode Client ............................................6-12
Trimpoints

video ...........................................................6-10

U

Unicode............................................................1-1
Uninstalling

client software.............................................2-15
server software............................................2-15

Updating
client software...............................................2-2

V
VDCP

commands.....................................................9-2
port mapping.................................................3-9
protocol.........................................................3-8

W
Wizard

Media Import ................................................5-6
BlackStorm Video Server User Guide (v1.1) Index • 3



4 • Index BlackStorm Video Server User Guide (v1.1)


	Manual Information
	Contents
	Introduction
	About This Guide
	Documentation Conventions
	Interface Elements
	User Entered Text
	Referenced Guides
	Menu Sequences
	Important Instructions

	Getting Help
	Contacting Technical Support


	Software Installation
	BlackStorm Client Usage
	Working from a Remote Computer
	Working Directly from the BlackStorm Server

	System Requirements
	Hardware
	Software

	Client Software Installation and Update
	DashBoard Configuration for BlackStorm Server Clients
	Installing BlackStorm Server Clients
	Updating BlackStorm Server Clients

	BlackStorm Server Software Update
	BlackStorm Server Software Uninstall
	BlackStorm Server Services

	Server Configuration
	Logging on to the Server
	Default User
	Administrator

	Network Connections
	Multiple Network Interface Cards

	Server Performance
	Firewall Configuration
	Client Configuration
	Channel Name Configuration
	GenLock Configuration
	Remote Control Configuration
	Mapping VDCP Ports

	House Time Configuration
	Channel Time Configuration

	BlackStorm Server Client Layout
	Connecting to a BlackStorm Server
	Connection Status

	Accessing BlackStorm Server Clients in Dashboard
	Creating a BlackStorm Client Layout
	Saving a BlackStorm Client Layout

	Adding Media Items to a BlackStorm Server
	Loading Media Files through the Media Manager Client
	Deleting Media Items
	Exporting Media Files

	Using the Drop Folder to Load Media Files
	To load media files onto a BlackStorm Server through the Drop folder:

	Importing Media Files from Selected Folders
	Managing Media Items
	Mapped FTP Folder
	FTP Client


	Playing Media Items from a BlackStorm Server
	Playing Media Items
	Playing Media Items that Contain an Embedded Alpha Channel

	Working with Media Item Buckets
	Custom Media Item Playout
	Viewing Multiple Timecodes in One Place
	Customizing the Timecode Client Layout


	Working with Playlists
	Creating Playlists
	Editing Playlists
	Targa Duration

	Playing Out Playlists

	Coloring BlackStorm Clients
	Client Background and Text Colors
	Customizing Colors
	Defining a Color Using HSB
	Defining a Color Using RGB


	Appendix A. Specifications
	Media Formats and Codecs
	Media File Formats
	Codecs

	VDCP Commands for the BlackStorm Server
	Communication Serial Port

	Index
	A
	B
	C
	D
	E
	F
	G
	I
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W


